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Preface

Thank you for buying our products. Our machine is professional and
high-technology equipment combined with the optical, mechanical and electrical; here
especially edit this manual for your good operating and maintenance.

We also take many real object photographs in the manual; it helpfully introduces
installation & adjustment, maintenance, safety attention etc. in details.

The user should read this manual in details before using, because it will help you
have a good grasp of operating and maintenance.

Welcome to provide your valuable comments or suggestions, will highly

appreciate it!
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| Manual of laser machine

Statement

1. Any differences are not specially notified in advance for products update etc.
reasons.
2. All products according to the real object, manual's photograph maybe different with

real object for products update etc. reasons.
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Safety Note

% The users should read the related operating manual carefully before operating. Must
obey the operating regulations strictly. Non-trained people are forbidden to operate
machine.

% The machine uses IV LASER (strong laser radiate), this kind laser radiation might
make following accidents:

(DEasy to burn around combustible materials; @ Different working materials might
produce other radiations and toxic or harmful gases during laser processing; @Laser
radiation's direct sunlight will cause body harm;

The machine location must equip fire-fighting equipment, so forbidden something
combustible and explosive around the machine, keep drafty. Non-trained people are
forbidden to operate the machine.

% Processing material and emission should conform to local laws and regulations

% The user should consider carefully whether processing materials are suitable for
laser working for risk reason.

% There are high-voltage and other potentially dangerous in the machine,
nonprofessionals are forbidden to disassemble machines.

% The operator is forbidden to leave during operating and must cut off switch when
finishing work.

Y Forbid open any cover during working.

% Make sure the wire connects well with the ground before operating.

% Forbid the things inconnected diffuse reflection around the machine for fear the
laser light reflect the person or incendive directly (advice use firehosereel box in
location of working).

% The operator must observe carefully during the working of machine, if something is
exceptional, should cut off all the switch.

% Keep the machine in the dry place, non-pollution, non-concussing, non-strong
electricity, strong magnetism etc.,environmental temperature should be

5-40°C ,environmental humidity should be 5-95%(no condensed steam).

% The laser machine needs far from sensitive EMI equipment, it will make EMI to this
kind equipment.

% The machine is forbidden to open machine when the power supply voltage is
unsteady or mismatch.

Manufacturer won't take any responsibility and liability because of improper use
and user not obey above all regulations.
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| Chapter 1 Machine Appearance and Accessories

I.1.1 Machine Appearance (Different model will have different appearance,
according to the real object)

1. Right side is shown in Fig.F1-1

F1-1

2. Back side is shown in Fig. F1-2

F1-2
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I.1.2 Accessories set (according to the real object)

Your accessories set include following parts except machine (except option spare
parts)
1. Water pipe (air pipe), Air pump, Water pump (some installed in water tank), is
shown in Fig. F1-3:

&SP RESUN 174
ELECTROMAGNETIC
AIR PUMP

F1-3
2. Exhaust fan, smoke pipe, is shown in Fig. F1-4:

F1-5
1) Water tank (for this machine water tank is optional part), is shown in Fig. F1-6:
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F1-6

F1-7 F1-8

6. Ground Wire is shown in Fig. F1-9(customer need to prepare it by yourself):

F1-9
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| Chapter 2 Installation and Commissioning of the Machine

A complete working system is composed by laser engraving machine, the exhaust fan,
air pump, water pump, water tank, exhaust pipe, data transmission lines and so on.
According to the needs, the users can configure the computers, printers, scanners and

so on by themselves.
I. 2 Installation and Adjusting Steps
1. Laser Tube Installation

As the laser glass is fragile goods, the laser tube should be packed separately in order
to ensure its safety during the transportation. So the users must install the laser tube
before machine installation and commissioning.

Laser tube should be mounted on the back of the machine, open the protective cover of
laser tube; you can see the two Vee-blocks. As shown in Fig. F2-1:

F2-1
Put the light-emitting window (low-voltage end) of laser tube with the same side of
No.1 reflector mirror on the Vee-blocks carefully, and then latch on the rubber strip on
the Vee-blocks wear of laser tube, fix laser tube well. As shown in Fig. F2-2:

F2-2
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Attention: W The laser tube can’t be fixed too tightly to avoid damaging it; @ Be sure
to keep the water inlet (laser tube high-voltage side) is located at the bottom of tube to
keep the water filling the laser tube fully.
After Fixed the laser tube, the water inlet pipe which connect with water sensor should
be connected with the high-voltage side water inlet mouth of the laser tube; the water
outlet pipe should connect with the low-voltage water outlet mouth of laser tube (if the

weather is cold, in case of break the laser tube, we’d better scald the end of the water
pipe with boiled water to make it soft.), As shown in Fig. F2-3, F2-4:

A\l

F2-3 F2-4
All the connectors must be butted firmly to prevent water leakage. The rubber pipe
must be straight, can not be curled in order to avoid poor water flow.
Finally, let the high-voltage cable of the laser power supply connect to the
high-voltage side post head of laser tube, the low-voltage cable of laser power supply
connect to low-voltage side post head of the laser tube, as shown in Fig.F2-5 F2-6:

|

F2-5 F2-6

For security, please seal the post head of the high voltage side and low voltage with
silicon gel.
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2. Water Pump Installation
Please fill pure water into the water tank (the water level should be higher than the
pump at least). Let the water pump outlet connect to water inlet of the machine, using
another piece of water pipe connect to the water outlet of the machine ,and put the
other side of this water pipe into the water to complete the circulating water piping
connection. As shown in Fig.F2-7, F2-8:

F2-7 F2-8
Connect the water pump power supply, at this time we can see that the laser tube is
gradually filled with water. If the water can through the water outlet pipe smoothly, it
shows that the pump is working properly.
In order to ensure the cooling water flow of the laser tube normally, a water protection
sensor is installed in the water recycling system, when water pumps working poor or
abnormal, the laser engraving machine will come into the protection state
automatically. Then the laser tube will not emit the laser light. Therefore, in the course
of routine maintenance, you should pay attention to the clean water pumps and water

pipes.

3. Installation of Air Pump

Make the air outlet of the pump connected to the air inlet of the engraving machine
with air pipe; ensure the outlet can vent air normally after turn on the power. As
shown in Fig. F2-9, F2-10:

r

F2-9
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Air pump is very important in the system. High-pressure air runs through the air pump
and blew out from the laser light-emitting window of the laser head. On the one hand,
it can ensure the cleanliness of the focus lens, on the other hand, it can prevent the
material inflame by the laser light. Therefore, in the routine maintenance, the user
should pay attention to the air pipe, must ensure that it can not be twisty or damaged,
otherwise abnormal air may lead to burning materials.

4. Installation of Exhaust Fan

First, let the suction inlet of the exhaust fan connect to the dust suction outlet of the
engraving machine by a smoke pipe, and fix them with lock. And then take another
smoke pipe connect the outlet of the fan, and put the other end of smoke pipe to
outside. At last, connect the power supply wire well. As shown in Fig.F2-11, F2-12:

|

F2-11 F2-12

5. Safety Grounding

Morn laser engraver uses fourth type of laser tube. The type of drive is
high-voltage-driven, so during users use the machine, they must comply with the
"Safety Note ". On the other hand, it asks stringent requirement about the safety
grounding to the users. The safe Line-to-Ground Resistance should be less than 5.
Specific connection method are shown in Fig.F2-12, F2-13

Solid bar
4

4

F2-13

10
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Attention please, bad grounding can cause high failure rate of equipment and at
the same time may cause other safety incidents! ! !

The company won’t assume any responsibility and obligation to the fault and the
accident caused by bad grounding!!!

6. Optical Path Adjustment

After let all power cables connect well and electrify, turn on the engraving machine
power supply, at this time, the machine starts to reset and return to the last origin
point . All above shows that the machine is running normally, then turn on the laser
power supply, begin to adjust the optical path. As shown in Fig.F1-14:

: N ¥ t‘:ﬁ;’%z }1

i

F2-14

Firstly, adjusting the laser position. Make the multilayer adjusting paper stuck on the
1# mirror frame, and then push the "Pulse" key on the control panel. There will be a
burned point in the paper, check whether the light spot is in the center of the mirror, if
the light spot is not in the center o f the mirror center, we have to make the light spot
in the center of the mirror by regulating the location of the laser tube.

Then adjust the 1# reflector mirrors. Move the beams to the nearest place to the
1# reflector; push “Pulse” to get a spot in the paper. And then move the beams to the
farthest place from the 1# reflector, get another spot in the paper. We adjust the angle
of the mirrors by adjusting the three screws on the back of mirror (clockwise rotation
the above screw, the spot will be down; clockwise rotation of the lower left corner of
the screw, the spot will move to right; clockwise rotation of the lower right corner of

11
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screw, the spot will move to left.), to insure that all the spot are in the same place in
the paper when and where the beam we move.

After adjust the 1# reflector mirror well, the next, adjust the mirror 2# as we do at
the first step, move the laser head to the nearest side to 2# reflector , then make a spot
in the paper , then move the laser head to the farthest place to 2# , make a spot.

We have to adjust the further spot overlap with the first spot by adjust the screws on
the 2# reflector frame.

Note: As the best, the location of light spot should be in the center of mirrors. The
light spot can not hit the edges of the mirrors. If playing in the edges, please
continue to adjust the mirrors until the light spot in the central of them.

At last we have to check whether the light spots are superposition wherever the
laser head is. If the spots can not coincide, please re-adjust the optical path by the way
we talked above until the spots coincide

After finished the adjustment, we will check whether this laser spot is playing in
central of the laser head light hole. If not, turn off the laser power supply, adjust the
laser tube position. If it is left and right excursion, which side is biased on, we move
the laser tube to this side direction. Such as: if left, we adjust the laser tube to left ; if
right , we adjust the laser tube to right .

If the migration is up and down, we have to adjust the laser tube to the opposite
direction, that is, if up, we will make the laser tube down; if down, we will make the
laser tube up.

Note: The above adjustments is just for a low-voltage side of laser tube (light side),
if we want to adjust high-voltage side of the laser to achieve the same effect, then
the adjusting direction is opposite.

The detailed description of how to adjust optical path, please see Chapter 4
"Alignment Standards of Optical Path".

After adjustment of optical path, please close the laser tube protective cover.

12
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| Chapter 3 the Operation of laser machine

Besides use the computer to control the function key, we can use the Control
Panel. The following is the brief instruction of control panel and main function.
There are 16 function keys and one LCD Panel in the Control Panel:

[.3.1 Introduction of Main Interface

Idle Interface  (display system time: day/month /year)

File: XX File Number: XXXX
Max Power: XX.X%

Run Speed: XXX mm/s
System Idle: 25/12/2010

Figure: 3.1-1
Running Interface (display run time of the selected file: hour/minute/second)

File : XX File Number : XXXX
Max Power : XX. X%

Run Speed : XXX mm/s
System Run: 00.12.40

Figure: 3.1-2

13
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Main Interface (Pause)

File: XX File Number: XXXX
Max Power: XX.X%

Run Speed: XXX mm/s
System Paused: 00.12.40

Figure: 3.1-3
Run finished interface (display the total run time of the last file: h./min./sec.)
In this interface, if “ESC” key is pushed down, the interface will return to idle
interface, that is to say, the figure 3.1-1.

File: XX File Number: XXXX
Max Power: XX.X%

Run Speed: XXX mm/s
System Idle: 25/12/2010

Figure: 3. 1-4
The interface in Figure 3.1-1 shows when the system is idle. “File”” means the number
of the memory file presently selected by the operator. If it is 00, it means the memory
file is not selected. “File Number” means the processing times of the current file
number. “Max. Energy” and “Speed” separately mean the maximum energy and the
engraving speed set on the keyboard. Maximum energy is expressed by percentage and
accurate to 0.1%. The unit of processing speed is millimeter a second (mm/s). When
there is a laser tube, the interface only shows the maximum energy of this tube as
shown in the above figure. If there are two laser tubes that are enabled, the interface
show the maximum energy of two laser tubes. The main idle interface is taken for
example as shown in Figure 3.1-5. On the interface shown in Figures 1-1 and 1-4, you
can press any keys on the keyboard. On the interfaces shown in Figure 3.1-2 and 3.1-3,
some keys can’t respond.

File: XX File Number: XXXX
Max Power: XX.X%/ XX.X%

Run Speed: XXX mm/s
System Idle: 25/12/2010

Figure: 3.1-5

14



User’s Manual of Laser Engraving / Cutting software

[.3.2 Introduction of key
(1) Reset

On any interfaces, press the Reset key (or when the system is powered) and the
mainboard will be reset. The machine will seek for the origin (configured according to
the user’s parameters through start-up and reset) and show the “Reset-in-progress”
prompted in the interface. The machine having successfully returned to the origin, the
laser head will automatically move to the setpoint set last time. If the last processing is
successfully completed prior to the resetting, the system will at this time return to the
interface in Figure 3.1-1; if the last processing is not completed (i.e. the power supply
Is cut off during the processing), the system will at this time show as follows:

Whether to Power-off restart?

Yes to “Enter”
Noto “Esc”

Figure:3.2-1
Pressing the “Esc” key in this interface and this de-energizing for continuous
engraving will be cancelled and the system return to the interface in Figure 3.1-1. If
processing was once started, the figure uncompleted in the former processing can’t be
de-energized for continuous engraving; if the “Enter” key is pressed in this interface,
the de-energizing for continuous engraving can be started in order to process such a
figure continuously.

| % After the de-energizing for continuous engraving is started, the

interface will show “Looking for cutoff point, please wait”. The
Prompt waiting time has something to do with the data size of last
processing. The larger the data size is, the longer the search for the
cutoff point by the mainboard is. Generally speaking, if the power
is cut off after the figure processing of one hour, the time that the
mainboard looks for the cutoff point is approximately one minute
when the de-energizing for continuous engraving is started after it is
powered next time.

(2) Laser

15
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On the system idle interface, the work finished interface, the system paused
interface and the interface to prompt whether to de-energize for continuous engraving,
press the “Laser” key and the laser outputs on the bursting. The time of open laser may
be set. If the time is set to zero, then the outputting time is the time when the “Laser”
key is pressed, that is to say, press this key for outputting and release it for blanking. If
the time is not zero, such as, 100ms, then the laser flash 100ms when you push down
the laser key. You can press the “Down” key on pressing the “Laser” key to start
manual cutting. The laser energy of burst is the maximum energy value set on the
keyboard. It is no use to press the “Laser” key on other interfaces. If the water
protector is started and something wrong happens to the protector, no laser will be
outputted after the laser and the interface prompts dislocation.

Max
Power

On four main interfaces (i.e. idle system, running system and suspended system,
work finished interface) this key can be pressed. On pressing this key, if the
manufacturer only provides a single laser tube or if there is a double-path laser tube,
but the user only enables one path, it only shows the maximum energy of this-path
laser tube and the interface shows the same as Figure 3.2-2. If two laser tubes are
enabled together, it will show the maximum energy of two laser tubes and the interface
shows the same as Figure 3.2-3.

(3) Max. Power key

Max. Power XX.X% Max. Power 1  XX.X%
Max. Power 2  XX.X%

Esc Enter Esc Enter

Figure: 3.2-2 Figure:3.2-2
(4) Min. Power key

Min.
Power

The display interface and the operating mode of this key are similar to those of the
“Max Power” key.

(5) Speed key

16
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On four main interfaces (i.e. idle system, running system and suspended system,
work finished interface) this key can be pressed. Press this key and the interface will
show the same as Figure: 3.2-4.

Speed: XXXX mm/s
Enter Esc

Figure: 3.2-4
The operating mode of this key is similar to that of the “Max Power” key.

When the PC software generates the cutting/engraving data file, if a certain or all
the parameters of the maximum power, the minimum power and the speed parameter
are set at 0, the value set on the keyboard will be taken as the corresponding parameter
in the idle state. Once the work is started, what is shown in the display interface is the
parameter of the layer that is being processed now.

The power and the speed parameters corrected when the work is not started will
influence the following operations: bordering, bursting and manually shifting the axle
on the keyboard. If the three parameters will be modified after the work is started, it
will only influence the layer that is being processed, but neither the keyboard
parameters set in the idle state nor other layer parameters.

Online parameter correction of the layer that is being processed
% can greatly facilitate the user’s searching for a reasonable laser
Prompt | power and speed matching value.

(6) File key

Press the “File” key in the idle system interface or the work finished interface and
two pages will appear. Press the “Up” and “Down” key and you can turn the pages up
and down. The interface will show the following in turn:

Memory File
USB File

Work Time Preview Figure:3.2-5
Delete All Memory Files

17
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Format Memory
Clear All File Number

Total File Number: XXXXX Figure: 3.2-6
Clear Total File Number

Brief the following items separately:
€ “Memory File”: the related operations on the memory file such as processing,
bordering, copying, deletion and etc.
€ “USB File”: the operations on USB file, such as copy to memory and deletion.
€ Work Time Preview”: press this entry, the work time of the currently selected file
will be calculated (you can also lower the memory file on the menu to start the work
time preview feature of a certain file), calculated time according to the file size and
complexity of the graphics, in general, if the actual work time is several hours, then
the calculated time may require ten seconds or even more. The work time calculated is
consistent with the actual working hours, accurate to the millisecond.

@ “Delete All Memory Files”: to delete the data of all memory files on the mainboard.
€ “Format Memory”: to format the memory on the mainboard. There are “Quick
Format” and “Complete Format” for option. If there is some abnormity in memory,
you may check the invalid block with the format function

@ “Clear All File Number”: to delete the corresponding processing times to each
memory file.

@ “Total File Number”: to show the present total times of processing by the machine.
@ “Clear Total File Number”: to clear and recalculate the total file number.

Move the cursor by way of the up and down directional keys to select an item first,
and then press the “Enter” key to enter the submenu. On selecting “Memory File” or
“USB File”, if the callee has no files, the interface will show the information of no file,
otherwise it will show the numbers and names of all object files (the suffix name of
object file is .rd). The processing times corresponding to this file is shown after the file
name in the “Memory File” interface. Each page has four files:

XX s XXX XXX XXXXX

XX s XXXXXXKX XXXXX
XX XOOOXXX XXX Figure: 3.2-7
XX e XOOXXXX XXX

18



User’s Manual of Laser Engraving / Cutting software

Select a certain file by pressing the directional keys (move the cursor with the up
and down keys and turn pages with the left and right keys) first, and then press the
“Enter” key to enter the submenu. For memory file, it supports such six items as
“Copy to USB”, “Run”, “Deletion”, “Work Time Preview”, “Track Frame” and “Clear
File Number”.

On pressing the “Enter” key when you select the “Run” item, directly start the
processing of this file and the interface shows the same as Figure 8.1-3 (Running
Interface); selecting “To USB” and pressing the “Enter” key, this memory file will be
copied to USB disk. If copying fails, the interface will show the error information; if
copying succeeds, the system will return to the prior interface after the bell rings. On
selecting the “Deletion” and pressing the “Enter” key, this file in the memory will be
deleted. Selecting the “Work Time Preview” and pressing the “Enter” key, to start the
work time preview feature of the certain file. If “Track Frame” is selected, the frame
of the graph is previewed. Then if “Clear File Number” is selected, the work number
of the certain file is set to zero.

For USB files, it supports such two options as “Copy to Memory” and “Deletion”,
the operation of which is similar to that of memory file. In the operation of file
copying, if the interface shows the error information, please press the “Enter” key or
“Esc” key and the interface will return to the prior one.

This system supports such file formats of USB as FAT32 and FAT16, but it can
@ identify them when the files are put under the root directory of USB. The file
Prompt name of more than 8 characters will automatically be cut out by the system.

The file name that has only English letters and digits will not show when they
are copied to the mainboard. The files copied from the mainboard to USB will
be placed under the root directory of USB.

Under the four main interfaces it is ok to press the Start/Pause key. Press this key
on the system idle interface or work finished interface; the selected file will be
processed. Press this key under the running system interface, and the work will be
suspended. Press this key under the suspended system interface, and the suspended

work will continue.

(7) Start/Pause key

(8) Origin key

19
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It will respond when this key is pressed under the idle system interface or the work
finished interface. If the single setpoint logic is selected by the system, press this key
and the mainboard will take the current X/Y-axle position of the machine as the
relative origin of the figure; if the multiple setpoint logic is selected by the system, it is
invalid to press this key at any time.

(9) Frame key

Frame

It is valid to press this key under the idle system interface and the work finished
interface. Press this key and the bordering will be operated on the currently selected
file.

(10) Esc and Enter key

Press the Esc or Enter key under different interfaces means to confirm or deny this
operation.
(12) Directional Keys (Up, Down, Left and Right keys)

(A V] [¢=] [m)

In addition to being used for modifying parameters and moving the cursor as
abovementioned, the directional keys can be used to move the kinematic axis under
such three interfaces as idle, suspended system or work finished interface. Under such
three interfaces, press the Left and Right keys to move X axis and press the Up and
down keys to move Y axis. If the inching distance is set at 0, the moving time means
the time of pressing this key, which means that movement starts after the one of the
keys is pressed and movement stops after the keys are released. Where the inching
distance is not 0, the corresponding axis will move for the corresponding inching
distance after one of the directional keys is pressed once. In the movement processing
the speed can be increased or reduced automatically in order to reach the
maximum/minimum coordinates. The maximum speed of key movement is the speed
value set on the keyboard when the system lies idle.

After the polarity of directional signal for each axle of the machine is
% adjusted well, if you press the Left key and the X axle will move
Prompt | rightward; and if you press the Up key and the Y axle will move down,
which mean the key polarity of the axles moving to the opposite
direction is not right. In such a case you should modify the key polarity
of this axle.
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(12) Z/U key (Function key) in the middle of directional keys

Z/U

The Fn key can be pressed when the system is idle or the work is finished. On
pressing this key, it will show three pages and nine entries in the following interface:

Z-axle Move Origin Setting+
Set to Default Para.

Load Default Para.

Axles Reset+

Inch Setting+ Auto Focusing
Laser Setting+ Langue+

Figure: 3.2-8 Figure: 3.2-8

1) Press the Up and Down keys to select the cursor position. When the cursor stops
at “Z-axle Move”, press the Left and Right keys and the system will move the Z axle.
If the inching distance is 0, Z axle will continuously move; if it is not 0, Z axle will
move the well-set inching distance value.

2) When the cursor stops at “Axles Reset”, press the Enter key and it will show
four entries as follows:

XY-axle Reset

X-axle Reset
Figure:3.2-10

Y-axle Reset
Z-axle Reset

Press the Up and Down keys to select the desired entry. Press the Enter key and the
corresponding axles will reset (Only when the reset of this axle is activated in the
manufacturer’s parameters can the resetting will function). Press the Esc key to return
to the prior menu.

3) When the cursor stops at “Inch Setting” or “Laser setting”, the inching distance
or the Laser shot time can be set.
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4) When “Origin setting” 1s selected, it will show below:

Multiple Origins: No/Yes Set as Origind
Set as Originl Next Origin 0

Set as Origin2 Origin Enable +
Set as Origin3

. Figure: 3.2-12
Figure: 3.2-11

2 Multiple Origins: “Yes” or “No” can be selected. If you select “No”, the
system will use the single-origin logic. You can press the “Origin” key and set
the origin, and only this origin can become valid. If you select “Yes”, the
system will use the multiple- origin logic and the “Origin” key on the keyboard
become invalid. In such a case, the parameter of each origin must be set in the
menu as follows.

2 Set as Origin 1/2/3/4: after the multiple- origin logic is enabled, you can stop
the cursor at “Set as Origin 1/2/3/4”. Press the “Enter” key on the keyboard
and the system will take the coordinate figures of current X/Y axles as the
corresponding ones to the origin 1/2/3/4.

2 Next Origin: there are such five digits as 0~4 for option, which are the origins
to be used for the next figure. Origin 0 means the origin set by the “Origin”
key on the panel in the single- origin logic. 1~4 means the serial number of the
origins in the multiple- origin logic. Next origin can be modified to any one of
origin 1~4, so as to control the start location of next work (the premise is that
the origin is enabled), but it can’t be modified to origin 0.

2 Origin Enable+: after the multiple-origin logic is enabled, the four origins can
independently be prohibited and enabled.

Once the multiple- origin logic is selected and if the serial number of the
% next origin is 1 and four origins are enabled, when the memory file
prompt | function is started or the processing file is uploaded into the PC and this
file selects “Take the Original Origin as current Origin”, the work started
for each time will use different origins. The rotation order of origin is
1->2->3->4->1->2.......

5) After the “Set to Default Para” in Figure 3.2-9 is selected and the Enter key
pressed, the interface will show the specific password to be entered when set as default
parameter. After the manufacturer regulates all parameters of the machine well
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(including all manufacturer parameters and user parameters), this function can be used
to store the well-regulated parameters to help users to recover the original parameters
(including all manufacturer parameters and user parameters) through selecting “Load
Default Para” when they regulate parameters improperly.

6) After the “Load Default Para” in Figure 3.2-9 is selected and the Enter key
pressed, the “Successful Recovery” dialog box will pop up to prompt that all
manufacturer parameters and user parameters are recovered successfully. You can
return to the previous menu by press the Enter key.

7) When the cursor stops at “Auto Focusing”, press the Enter key to search for the
focus(When there is z axes, and the z axes reset function is enabled, the auto focusing
is valid); press the Esc key to return the prior menu.

8) The item “Langue” helps you to select a appropriate langue which is displayed
on the panel.
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| Chapter 4 Alignment Standards of Optical Path

During common use, there may appear some deviation with the optical path,
resulting in no laser or light path is abnormal, then please refer to the following
method to adjust the optical path:

Step one: First to ensure laser beam from laser tube to the center of 1# reflector
mirror.

Step two: Affix multi-storey double sticky tape paper on the 2# reflector (Or other
objects can be marked on), move laser beam to closest location of laser tube, press
pulse (choose suitable power), get a spot on the paper (with special attention: In order
to prevent the laser radiation wounding, with a piece of cardboard first to test the
approximate location of the spot, and then adjust).

1#
laser tube ¢

Uy, 32

A##

Step three: Move away the beam to the position far from the laser tube, press
pulse, get another spot on the paper.
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1#
;&:j laser tube E::l

Y

T
24
a#

Step four: If the two spots are not superposition, adjust the screws on the back of
the 1#mirror to make the laser fire on the same position as the first spot.

Step five: Repeat the second to the fourth steps until the two spots overlap
completely. Moreover, the spots should be in the center of the hole.

Step six: Affix multi-storey double sticky tape paper on the 3# reflector ,move
laser head to the nearest position from 2# mirror, press pulse(choose suitable
power),get a spot on the paper.

1?&:3 laser tube I::]

2#

Step seven: Move away the laser head to the position farthest from the 2# mirror,
press pulse(first to detect the approximate location of laser with a piece of cardboard
to prevent wounding),get another spot .
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1# s
laser tube [::l

A4

Step eight: If the two spots are not superposition, adjust the screws on the back of
the 2# mirror to make the laser fire on the same position as the first spot.

Step nine: Repeat the sixth to eighth steps until the two spots overlap completely.
Moreover, the spots should be in the center of the hole.

Step ten: Affix multi-storey double sticky tape paper on the 3# reflector, press
pulse, get a spot on the paper. If it is in the center of light hole, then pass.
Step XI: If the laser light is not in the center of light hole, as below figure:

In the left Figure, the spot is upper and right biased.

Top to bottom bias: can only raise or lower the laser tube.

Inside and outside bias: only move the laser tube in or out to adjust.

In this case, it is essential to lower the laser tube (here refers to low-voltage side
of the laser tube), and then, from the beginning of all the re-adjustment of the first
step.
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Note: The operator can’t do the above working until after the professional
training. Otherwise, the operator do this working must with the help of the
professional . The operator must pay attention to security when adjusting, to
prevent the laser radiation wounding.

| Chapter 5 Daily Maintenance and Common Faults

The stable working of the machine is inseparable with normal daily operation and

maintenance. Here are some common daily maintenance and common faults analysis:
[.5.1 Daily maintenance

1. Replacement of the cooling water (clean water tank and replace recycled water
once a week are recommended):

Quality and temperature of the cooling water can affect the lifetime of laser tube
directly, suggest use purified water or distilled water, and water temperature should be
below than 35 °C.When higher than 35 °C please replace cooling water, or add ice
cubes to lower the water temperature,(cooling device is recommended, or use two
water tanks).

Note: To ensure that the laser tube full filled with cooling water before machine
working.
2. Cleaning of Water Tank

First of all, turn off power, disconnect the water inlet pipe, let the inside water of
the laser tube flow into the water tank automatically, open water tank, take out the
water pump, clean water pump and water tank, put the pump back to water tank, insert
the water pipe which connect water pump to water inlet mouth of the machine, finish
all joints, then replace cooling water. Turn on the water pump power supply isolately,
let the pump run 2-3 minutes (make laser tube full filled with water).

3. Cleaning of Exhaust Fan

After long time using, inside of fan will accumulate much solid dust, so the
exhaust fan will make a great noise, and it is not conducive to the exhaust .When the
exhaust effect become poor, we have to clean the fan and smoke pipe .Firstly, turn off
the power supply, remove the two pipes from the fan, clean dust inside of the pipes,
and then clean the dust inside of the fan.

4. Cleaning of Lens (daily cleaning is recommended before work, equipment must
be in shutdown state)

As we have talked before, engraving machine has three reflector mirrors and one
focus lens (1# reflector mirror is near the light outlet mouth of laser tube, the upper
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left corner of the machine, 2# reflector mirror is at left side of the beam, 3# reflector
mirror is on the top of laser head, the focus lens is located in the bottom part of the
laser head), the laser is send out by the mirror reflecting and focus lens focalizing.
Mirror is easy to be dirty, resulting in laser loss and mirror damage, you needn’t
remove 1#,2# and 3# mirror when cleaning them, Just using a cotton bar to dip some
cleaning solution (acetone or alcohol) , swab carefully by rotating from central to edge
of the lens.

Take out the focus lens from the laser head, using the same method clean it, after
cleaning, put it back.

Note: @ you should wipe the lens carefully, cannot damage the surface coating;
@ you should do that lightly, to prevent falling; ®keep concave side downward
when install the focus lens.

5. Cleaning of Guideway (suggest cleaning every two weeks, equipment must be
in shutdown state)

First of all, move the laser head to the far right (or left),wipe with a dry cloth until
shiny clean, together with a little oil (sewing machine oil is recommended),push the
laser head several times slowly along the guide, so that lubricant can be evenly
distributed. Clean and lubricate the Y axis two guideways is the same as X axis.

Note: Please prepare for cleaning Guide - dry cotton cloth, lubricating oil.
6. Optical path inspection

Optical path system of the laser engraving machine is completed by the mirror
reflection and focus lens focusing, and there is optical path bias with the focus lens,
but the three mirrors is fixed by the mechanical part, optical path bias is very possible
for them, although there is no optical bias normally, we still suggest you check optical
path before working.

Please get detailed explanation from Chapter 4 "Alignment Standards of Optical
Path "
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[.5.2 Common Faults Analysis

Phenomena
No. of Analysis method Solution
Malfunction
Check power supply of Make all power supply
Open the machine connects well or not | electrify again
1 machine but _ . Correct the parameters
Mainboard parameter is right :
no movement or not according to software
operating manual
: : : . Correct the laser
Working with | Mainboard parameter is right .
2 parameters according to
nonstop laser | or not .
software operating manual
Check water circulation is Clean water tank, water
Desultory swimmingly or not ump and water pipe
3 | light when & pump PP
. . Add regulator for the laser
working \oltage is stable or not :
machine
Correct the X and Y axis
Self-test : . . - .
Mainboard parameter is right | direction ,limit position
4 abnormal .
. or not parameters according to
when starting .
software operating manual
Check whether the data port
. Choose correct port
choice is correct.
Check whether turn on the :
After output . Turn on the machine
_ machine
5 | data,machine
. Check whether connected .
no action _ _ Connect ground wire
ground wire for the machine
check whether installed the inctall the USB driver
USB driver
Check whether optical path is . :
No laser bias P P Adjust the optical path
6 when i
. Check whether the cooling : :
working ) _ Ensure the water is running
water is running
Can’t detect
The computer or USB Change computer or USB
7 the laser . .
communication problem line

equipment
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| Chapter 6 Warranty Regulations
| 6.1 Warranty Periods

From the date of purchase, whole year warranty (except consumables). Optical
lenses and the laser tube are consumables, three months warranty.

| 6.2 Warranty Clauses

This warranty is for products of our company.

During the warranty period and under the correct use, malfunction can be based
on this warranty terms, show the warranty card or invoice, enjoy our free maintenance
service.

The following cases, can’t enjoy the free service, a fee will be charged according
to the concrete condition.

1) Maintenance services not caused by the machine quality;

2) Overstep the warranty period;

3) Can’t show or alter warranty card,;

4) Didn’t fulfill the contractual obligation;

5) Without the company agrees, privately to tear open outfit, modification,
maintenance of product;

6) Equipment failure due to human or force majeure factors.

The company only assume the legal obligation for the product itself, but don't
assume other responsibilities which caused by the using of the products.
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| RDCAM V6.0 User Manual

Il Chapter 1 Overview

[1.1.1 Laser engraving cutting system introduction
Laser engraving cutting system through a computer numerical control machine
tools to achieve effective control, according to the user’s different requirements of the
completion of processing tasks. This manual describes how to use the software to
complete the task of laser processing

[1.1.2 Environmental requirements
(1) Windows XP operating system and above, XP recommended.
(2) Above CPU586,above PIII or PV recommended.
(3) Memory, above 1G recommended

[1.1.3 Software running
Embedded software can be embedded in CorelDraw. AutoCad. CaDian2010 and
Illustrator CS5 software, the software is similar to the operation, embedded software,
installation methods, please refer to <<RDCAM software Setup Manual >>

1.3.1 Run CorelDraw
1>Run CorelDraw.

2>Import graph to CorelDraw, or draw some graphics.

At
3>Click toolbar Q4 button e,then RDCAM running.

1.3.2 Run AutoCad
1> Run AutoCad

2> Import grahic to AutoCad, or draw some.

3>Click toolbar ‘@ button

then RDCAM running.
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1.3.3 Run Cadian2010
1>Run Cadian2010

2>Import grahic to Cadian, or draw some.

3>Click toolbar button

then RDCAM running

1.3.4 Run lllustrator CS5
1>Run Illustrator CS5.

2> Import grahic to Illustrator, or draw some.

R
3> Click toolbar Q3 button © , then RDCAM running.
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Il Chapter 2 Software installation

[1.2.1 Install steps

(1) Double-click the RDCAMSetup.exe under the installation directory, the following dialog
box appears:

Al RDCANG. 0. 01 Install

Welcome to the RDCAM Setup Wizard

This wizard will quide wou through the installation of ROCAM,

It is recommended that yvou close all other applications befare starking Setup, This
will make it possible to update relevant swskem files without having to reboot vour
compukter,

Click. Mext ko continue,

Install | [ Cancel

(2) Click [Install] , when extract copy is to be completed, the installation main interface

appears:

Install USE driwver Uni=stall USE |
Type: |La5er'|'|'u:-rk W |
Language: |Sim1:-1if3r Chinese v|
Mainboard: \RDLC3Z0/RDCE33E v |
Danate install path
[|Pen drawing lines
Dﬂem-:- Terslon

Inztall Exit
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[1.2.2 Installation settings
The installer can choose different installation content.
1> Install/Uninstall USB driver , reference {Install USB driver)
2> According to the different customer application needs and the habit of using to
select the type of software
a. Stand-alone software LaserWork.
The software that plug-ins to CorelDraw. Support the version from Coreldrawll to X5.
The software that plug-ins to AutoCad. Support the version from 2004 to 2010.
The software that plug-ins to Cadian.
The software that plug-ins to lllustrator.
3> Choose a different installation languages
At present, it support Simplified Chinese, Traditional Chinese, English and the custom
language type.
4> Select the software matches the motherboard
The software can support three kind of motherboards:RDLC430. RDLC320. RDC633X.
Both RDLC320 and RDC633X are compatible, but RDLC430 is different. So, please choose
the corresponding software with motherboard. Otherwise, it does not work.
5> Locate install path
When install the LaserWork, default install path is “C:\", for change the install path, check this
option.
When install the plug software RDPIlug, under normal circumstances, the install program
will locate to the target software automatically. If the installer does not locate to the target
software automatically, you need to check this option, and locate to the target software
manually.
6> Pen drawing lines
This option is only applicable to a particular machine, which has the function of the chalk line,
ordinary machines do not need to check this.
7> Plug laserwork
The installer default install a special plug-ins RDPlug, if the users are more accustomed to
using LaserWork program ,can check this.
8> Demo version installation
According to the type of software installation, the installation language, the choice of
motherboard generate different versions of the DEMO Software.
[1.2.3 Installation
Choose the type of software, installation language and the appropriate motherboard. Click [Install]
to install the software. After installation is complete, the following dialog box appears to prompt the
user that the software has been installed successfully.

®aooo

ELasersetlip¥a @

-
\]}) Install Finish!

11.2.4 EXit
After installing the installation needed. Click [Exit] to end the installation process.
Because of the possible need to use several installation, so the installation dialog does not
automatically exit, until users click button [Exit] .
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[1.2.4 Other matters
1> Before installing the plug-in software, the software that has been articulated should be shut down.
After installation, restart the software.
2> The regular version and the DEMO version of the plug-in software is covered by each other.
3> In the default installation path, the normal version and the DEMO version of the independent
software and different types of independent software motherboard with each other.

For the same time to install two versions, select the [Locate install path] .The regular
version and the Demo version should be installed in the different location.

In addition, need to the appropriate software installation location, manually add a desktop
shortcut for the software.

4> Modify the information of manufacturers

In the package, in addition to RDCAMSetup, there are four text files.

Info_Sche. Info_Tche. Info_En. Info_Other, the four files correspond to the software
information of manufacturers that be displayed in Simplified Chinese, Traditional Chinese, English
and the custom language. If the four text is modified, manufacturer information also will be installed
when the program was installed.

Open the text that should be modify, an example in Simplified Chinese:
0 = Company Name:

1 = ... (Fill in company name here)

And so on, the company information in other languages is the same set.

[1.2.5 The plug-in of CorelDraw installed

Plug-in software support the version from CorelDraw11 to X5, but some simplified versions
of CorelDraw is not supported. Here to the installation of CorelDraw12 as an example to
introduce the installation process of plug-in software. If not specified, it is referring to
CorelDraw12.

Before installing the plug-in software to run CorelDraw.

| Tools| Window  Help
Opticns... Ctrl+) |
Customization...

Save Settings As Default

[fl | mEE
| | T

Color Management [
Proof Colors

Color Proof Settings...

Select [Tools)] -> [Option]
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i 4
TN
= Workspace

- General VBA

- Display Security
- Edit
--Snap to Objects [ Security Options...
- Diynamic Guides
- \Warnings

Trust all installed GMS modules

[7| pelay Load vBA

- Save

- PowerTRACE
- Plug-Ins

[+ Text

[+ Toolbox

[#- Customization

+- Document

+]- Global

In the pop-up dialog box, select VBA, on the right do not check the “delay load VBA”, then
OK, and exit the application CorelDraw.
Run the program of installation, choose “Type” to “CorelDraw_Laser”, then click

¥elcome to use

Install USE driwer

Unistall 1USE ]

Type: | Corellraw Laser
Lemgrages English v|
Mainboard: \RDLC3Z0/RICE3ZE v

DLocate install path
DPen drawing lines
I:‘Plug Lazerfork

DDemo verslon

[ In=tall H Exit ]

[Install] .

The installer will automatically install the plug-in software to the all versions of CorelDraw
RDCAM that are installed on the operating system and pop-up dialog box.

BlLazerSetlp¥6 [E|
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For some versions of CorelDraw (such as green version) may not automatically navigate to
the locate where the CorelDraw is installed on. Only need to check “Locate install path” on
the installation software, and then manually browse to navigate the folder location to the root
of CorelDraw software where the plug-in program should be installed on.

Exit the installation program, and run CorelDraw.

Toolbar in the CorelDraw interface will appear ‘0_‘

If the button does not appear, you should select [Tools] -> [Option] in the menu.

- Wariepace Command Bars
- General
- Display Menu Bar Size
- Edit [] ContextMenu ... Button: Border:
“SEp e Status Bar (Sml = 2 &
- Dynamic Guides Etandard
~Warmings Property Bar
;:Ce ik [[);:af:ll:futhon Appearance vJ
- PowerTRACE L] Text
- Plug-Ins L Zoom
- Text [] Internet Other
(- Toolbox L] Print Merge Show title when toolbar is floating
=l Customization L] Transform Lock Toolbars
- Command Bars Macros
- Commands RlLaserCut5.0
- Color Palette
‘... Application
[+]-Document
[#)- Global

On the left select the “command bar” and then check “Visual Basic applications”, and select
‘GOK’7-

= = . l:: _I ] ] ] .
b |¥" i , this tool bar will appear in the software, select the first button b
If the toolbar does not appear, reinstall the software CorelDraw.
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CorelDEAY 12 ¥Wisual Bazic for Applications = [5_(|

EETR W) __
FlLazerVE. UserInit 1217 @)
ElLaserVE, ImportlstFile B
FElazer¥B. LazerWorli ni

FEA] (2)
$E (E)
AR (D0
EHINE |Glnbalh1&cru:|5 (FlLaser1ZV6. gms) V|
it

In the “macro location” select “GlobalMacros(Rlaser12V6.gms)”.
And the “Macro name” choose the RlaserV6.Userlnit. And then “Run”.

[1.2.6 The plug-in of AutoCAD installed
AutoCad plug-ins can be used to AutoCad2004-2010 non-simplified version. Here to the
installation of AutoCad2004 as an example to introduce the installation process of plug-in. If
not specified, it is referring to AutoCad2004. Close all running AutoCad programs before
AutoCad plug-in installed.

Run Setup. Select “AutoCad Laser” as The “Type”, and then click [lnstall] .

¥elcome to use

Install USE driwer

Uni=tall USE |

T}"_FIE: .I,ﬂltl:ﬂ:j,.]:l_]'_,:ag aY
Langnage English v
Mainboard: \RDLC3Z0/RDCEI3E v |

Lacate install path
[] P

| |Pen drawing lines
DPlug Lazerfork

D]:Ieml:- version

[ In=tall H Exit ]

Setup will automatically install the RDCAM plug-in software to all versions of AutoCad
that were installed on the operating system and pop-up dialog box.

ElLazerSetUp¥6 E'

-
1 ) Instsll Finish!
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For some vesions of AutoCad(such as green version) may not navigate to the locate
where the AutoCad was installed on. Only need to check “Locate install path” on the
installation software, and then manually browse to navigate the folder location to the root of
AutoCad software where the plug-in program should be installed on.

Exit the installation program, and run AutoCad.

Toolbar interface in AutoCad will appear Q@

If the button does not appear, select [Tools] -> [ Macro] (A)->Macro(M) in the menu.

£E @ FEWE o \EPRRTEIQ 'O o) #Eho

dmtodesk FAEE (a) l B Standard w| | 150-25
CAD #RitE (5D L

MEWRE [E)
RIS (5. . @
SFIREF @) »
=il @) r

FEI4RER (). ..

TR EESR L) Ctrltl
T L () Ctrlts
TEEINEFTOE) Cirlts
SEEIEE @) Ctrl+e

| p— vl [—1

DnEk Rz L.
IETHE R .

AutolISF (3] r mETIHE L. ..
VEA BESE V). ..

T EHR ) v
airag UCS N,

Visual Basic $R¥Eag (B) ALt+F1l

If you can not find it in the menu, it is because the version of AutoCad may not support
the plug-in. Pleast re-install a full version of AutoCad.

-z 2K

EETR M)

L \Program Files'AutoCAD 2004%acad. dvb!Lazer¥Wf. LaserInit =47 (R)
C:"Frogram FileshAutolAD 2004%acad. dwb!Laser¥B LaserIni
C:\Program Files'AutolAD 2004%acad. dvb!LazerVB. LazerBuns

FEEh (1)
IEEA]2)
e (£)
H#IEs: (D)
£ ¥ [vEA ETERE ().

EUE R | FFREEERTTE w T @), ..

1RER (D) :
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In the pop-up dialog box, select Laserlnit, and run.

The plug-in toolbar can occur if you select this option, but when you close AutoCad and
then open the AutoCad software again. But also do not see the toolbar. Then it is possible
that your computer is infected with a virus. You must manually to define the boot loader
works of AutoCad, or you can re-check for viruses or reinstall the operating system and
AutoCad software.

Manual process of loading plug-in as follows, select the menu [ Tools] ->AutoLISP->

Tn#k.

£ED WEWE ol \EERTIEIQ 'O o)

butodesk FIEL (4 B Standard v| A
CAD FRiE (3D 4 l

HERE E)

ERIEIERE (). ..

ZTIRE @) ’
=i @) »

[EtERE . .

TR EERR (1) Ctrltl
it (3 Ctrlts
THEMEHO F)  Ctrlts
B EEIESE (1) Ctrlth

g IR L)

IETTRIE (R ..

R ’

At olISF (3]

I ,|  Visual LISF gRiEEs (V)

In the dialog box, you should to choose the “Content” button that was under the “Start
Group”.

/B AR ?)X
EHIEE (D) | ) utoCAD 2004 ~“ O F e E-
[_)Data Links [ JFlotters [)WebDepat
) Trw |[)Sample [ WebServices
[)Fent= |[)Support acad. dvb
[(JHelp ) Template AcApp. arx
I[JLa=erforkyS ) Textmres Acﬂrra}'. ary
L )Flot Styles UserDatalache AcArxAdlm. ary
< >
IS m: Tngk (L)

ICHZERI T | AutoCaD FEFAIERE Ok avxow lopok, dwh; |
ENMEREHEEF | mRiERiE OFmalmEeias @)
It RET &
Bahil
AcDBICL. .. CohvProgram Files“hntoCAD .. % L
< » P @, ..
[ =D | [ #Fw |
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Select “Add” button in the pop-up dialog box. In the AutoCad directory, manually locate
and select acad.dvb,acad.Isp. And loading these two files.

FEFIERRIRS
I BT
i acad. dvhb C:\Program FileziAutoCAD 2004%
arad. l=sp C:hProgram Files‘AutoCADl Z004%
EEN RN

Adding the file, close the dialog box, and then close the AutoCad. You can see the plug-in
toolbar when you open the AutoCad again.

[1.2.7 The plug-in of Cadian installed
Cadian plug-in are now available for the non-simplified of Cadian2010. The other version is
not tested. When Cadian was installed, you should close the running Cadian procedures.

Run Setup. Select “CaDian Laser” as the “Type”. And then click [lnstall] .

¥elcome to use

Install USE driwer Unistall USE |
Type: Calli an Lazer
Languaze: English
Mainboard: RDLC3Z0/RICE33E W

Locate install path

] P
Fen drawing lines

o g

DPlug Lazerfork

D]:Ieml:- version

[ Install H Exit

As CaDian is green software, installation program can not automatically find the
installation directory where the need to manually locate the installation path. Select the
CaDian installation folder, and click “OK” button.
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“3 Browse for Folder

Select destination Folder. 'Wisual Assist %' will be added to the
chosen path,

lfj AutoCAD 2010 N
() AutoCAD LT 2005 B
Il-j putodesk
ll-j Business Objects
s FCAD:anZ010
ll-j CE Remote Tools
Il-j Common Files

ll-j ComFlus Applications
ll-j Corel
ll-j DAEMON Tools Lite
F4 easvilule

| 4

IA

I >

[ OK ] [ Cancel ]

After installation is complete, the following dialog box appears.

RlLazerSetUp¥6 E'

1 } Instsll Finish!

Exit the installation program, and run CaDian.

[1.2.8 The plug-in of lllustrator installed
Illustrator plug-in are now available for the non-simplified of Illustrator CS5. The other
version is not tested. When Illustrator was installed, you should close the running Illustrator
procedures.

Run Setup. Select “Illustrator Laser” as the “Type”. And then click [lnstall]
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In=tall USE driwer Ini=tall USE ‘
Type: Illustr:at-:-r_L:as-‘-_-r Vl
L omsnoge! Simplify Chinese |
Mainboard: \RDLC320/RICE33X |

Danate install path
DPEIL drawing lines
DPlug Lazerfork

I:‘ Demo wersion

| Install || Exit

As lllustrator is green software, installation program can not automatically find the
installation directory where the need to manually locate the installation path. Select the
Illustrator installation folder, and click “OK” button.

42 Browse for Folder

Select destination Folder. 'visual Assist %' will be added to the
chosen path.

) 95599 Certificate Tools A
() 39080508

= Ib Adobe
[C) Adobe T1lustrator CS4
I ET11lustrator CS5
[C) Photoshop CS
ll-j Reader 9.0

F-{) Ahead

#-) Alifangiang

|b American Laserfare
[ Answerforks 4.0

|4

|A

2

[ OK ] [ Cancel ]

After installation is complete, the following dialog box appears.

RlLazerSetUp¥6 E'

1 ) Instsll Finish!

Exit the installation program, and run Illustrator.
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Il Chapter 3 Introduction of CorelDraw_Laser

11.3.1 Main interface

After RDCAM running, will see the following interface. Familiar to this interface, will

helpful to use the software for laser working.

Layer para Plot area Graphics bar Layer toolbar

EDCANG. 0. 01

Layer Mode Spedd MinPower | MaxPower  Output

] Cut 100.8 300 300 Yes
. 100.0 20.0 20.0 Yes ||
Q_()Q PRRED D RDD Dy
ﬁ 9
@WOOW@;) 3 |
@ ““ﬁ = d@ 0) |m
; ) o {>
Export | General | Machine | Document | Manual | Info || Config Q‘ .
G’
Path optimize Operatmg area D & D %“v g 8 O
[ criginal or edit path [ClEnable rotate engrave > 4 .
g Order of layer - 8
Inside to outside Diarneter{mm): O
Auko determine start point and dir % DQ d) é Q§\> 8
[ auto find start point @ d
Wash L
e P cPemee g o %@ RISy
Height: |50 Dir: |Up ko bott s G D
0O O
Linefcolumn setup ] G %
# Nurn: |1 wspace(mm): [0 Feecing Count: © DRDDDIDODO0 0) &O
Diskancefmm):
¥ Nurn: |1 ¥space(mm): [0

urrent positiorfiss [ UISE: Auto ] [ Start ”}{E,I'CDHUHLIE” SaveTolFile ]

ition: |- ; — : .
Bestrewing breadth. .. E Position
[]oubput select graphics [ Go scale ” Cut scale ] [ Stop ‘n Download ” UFileCutput ]

Abiout

Layer para: Depending on the graphics processing requirements layer configuration process
parameters.

Plot area: Display graphics to be processed and simple graphics rendering.

Graphics Bar: Graphics property bar is the basic attributes of graphics operations, including
graphic location, size, scale, number processing.

Layer Toolbar: Change the color of the selected objects.

Control Panel: All operation relate to processing.

Operating area: basic operation.
[1.3.2 Language settings and machine information

In addition to installation process can set the software language type, you can easily
switch in different language.
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Export || General | Machine | Document | Manual | Infe | Config

Import Setting

PLT Precision: v
[] smooth curves Smooth precision(®:): |30

Auto close curves Close error{mm): |0.1

Combine lines Combine errar(mm: (0,1

Auto gray scale

[ ] Import Dxf text info

Export Setting:

Passwaord | Export Precision(%s): |50
Mendor param |

YWelocity Unit: | mmy)'s w

1B 5/Language: |English  »

Select the desired type of language, can easily switch between different languages.
To obtain manufacturers information, so that we can provide you with better service.

Click Menu Bar [Help] -> [ About] .

About E|

Corp, Mame:
Tel:

Fax:

Addr:

Weh:

ROCAMY6.0,01 oK

The bottom of the dialog box shows the current software version number. As different
versions of software may be have some differences on the functions and interfaces, you can
easily contact and communicate with manufacturers through software version number.

11.3.3 File parameters setting

€ PLT Precision: According to the accuracy of the original plt file to select the
appropriate import unit.

€ Smooth curves: When import vector file, automatically smoothing the original
curves. For the original graphic is smooth or need to repeatedly adjust the beset
smoothing effect, you can uncheck this button. Do not do smoothing curves may
reduce time of import processing.

€ Auto close curves: According to close tolerance automatic check and closed curve
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€ Combine lines: According to merger tolerance, auto-connecting curves.

€ Color map automatically switch to grayscale: Because under normal circumstances,
graphics are based on grayscale. If the imported bitmap is a color image can be
converted to grayscale.

€ Import Dxf text info: When the user need only Dxf the graphic information, not need
the text information within the file, do not check this.

€ Dxf Unit:
The default dxf unit of software is MM. Users can change it to CM. inch and custom.

€ Export precision: The precision of export output file (rd format).

€ Velocity unit: Software supported two types of speed unit: mm/s. m/min. Selected
according to usage. After it was selected, the speed of parameters on the interface unit
will change with it.

Export | General | Machine | Document | Manual || Info | Config

Impork Setking
[1&month curves:
Auka close curves Clase errar(rmrm): (0.1
Combine lines Zombine error{mm): |0.1

[ ]tmpart Dxf kext info

[vsF mik: MM w

Export Setking:

[ Password ] Export Precision(%s): |80

[ Yendor param ]

Yelocity Unit: | mmy)'s b

185 JLanguage: |English w

[1.3.4 Object Selection
In the process of drawing and edit graphics,first of all is to select the object.
When the object is being selected,in the center of this object will have a shaped mark* x ”,
and surrounded by eight control points.
Click menu [ Select], switch to status“Select”. Under this status, you can select object.
The following are five kinds of method of selecting
€ Shortcuts Ctrl+A, select all objects.
€ Click mouse on the screen to select single object
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40
<
(10

€ Select object using select box

Press the mouse and drag, as long as the box come into contact with the object will be
selected.

€ Increased select object/minus select object

Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box select the selected object.

€ Select object according to layer

Layer Mode Speed MinPower | MaxPower  Qukput
[ ] Cut 100.0 30.0 30.0 Yes
[ ] Cut 100.0 30.0 30.0 Yes
[ ] Cut 100.0 30.0 30.0 Yes

Cut 100,10 30,0 30,0 Yes
[ p ] [ Do ]

Right-click the selected layer, then the part of all objects in the layer will be selected.

[1.3.5 Object Color
The color of object that is the color of the object contour. You can click the color
button on the Layer Bar to change the color of the object has been selected. The color of the
pressed button is the color of current layer.

[1.3.6 Object Transformation
Transformation of object mainly include: object location. orientation and size. But

does not change the basic shape of the object and its characteristics.
Transformation of object for users, provides a convenient user interface.
You can also use the Object Properties toolbar

% [531.841 | W (182,197 | i | [100.0] 2, a

¥ |-139,700) mm F 281,255 | mm | [100.C] o
You can also use the right transformation tools to transform and copy the graphics.
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[1.3.7 Place object
Place the object is to facilitate the view or position. Right-click menu functions can be
docked in the object will be placed on the page selected several special position (upper left,
upper right, lower right, lower left, and center of the page), and if placed in another location,
you can use the 2.6 object transform feature implementation.

v Select

View r

Draw k

Cut property ¥

Tools r

Mign »

Docking k Top left

Group Top righi.;
Bottom right
Bottom left

Freview Center

[1.3.8 Object align
Select multiple objects, use the alignment tool in the context menu on the selected object
to a variety of publishing operations.
Align the base object: Press SHIFT for a single object in turn check for an object to the
final choice as a benchmark. Curve number for the marquee to the object at the bottom for
the benchmark.

v Select
View »
Draw k
Cut property F
Tools o
i Lot
Docking k Align RBight
Group Allgn Ter
Align Bottom
Mign Horz Center
Freview Align Vert Center

Align Center

Arrange space horizeontal
Arrange space wertical
Resize width

Besize height

Besize size

11.3.9 Object View
The view of the object can be used in the viewer right-click menu.
€ Translation: Click [View]/[Movel, Then hold down the left mouse button in the
drawing area, drag the pan.
€ Marquee view: Click [View] / [View select] .Mouse to the drawing area, hold
down the left mouse button and drag in the drawing area displays a marquee in the dashed
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box, release the mouse, were framed in the region will be the largest share in the drawing
area to display.
€ View page: Click [View]/[ View Page Frame]. You can view the full page display.

€ View data: Click [View M View Data Frame ). You can view the full selected object.
[1.3.10 Group and unGroup

Edit graphics, and sometimes need to be a part of the operation as a whole (such as
multi-line text layout).
Method: Select the group of graphics, and then select the menu [Edit] / [Group]

( [UnGroup] ).
[1.3.11 Basic graphics creation

€ Line
Click menul Line ],drag the mouse on the screen you can draw an arbitrary line. Press the
“Ctrl” key while dragging the mouse to draw horizontal or vertical line.
€ Polyline
Click menul Polyline]. Drag the mouse on the screen you can draw an arbitrary polyline.
€ Rectangle
Click menu [Rectangle] . Drag the mouse on thescreen you can draw an arbitrary size
rectangle.
Press the “Ctrl” key while dragging the mouse to draw square.
€ Ellipse
Click menu [Ellipse] . Drag the mouse on the screen you can draw an arbitrary size
ellipse. Press the “Ctrl” key while dragging the mouse to draw round.
€ Point
Click menu [Ellipse] . Click the mouse on the screen, you can draw a point.

[1.3.12 Important Tool
Here are some frequently used tools. Using these important tools, can make the

current document in the graphics more orderly, and make the processing of output

more fast.
[1.3.12.1 Manual sorting and the set of cutting point and the cutting direction

Software provides users a convenient tool for the manual sorting. Select [Edit] -> [ Set

cutting property 1. Cutting property dialog box will pop up. All with manual sorting, and cut

points, cutting the direction of the settings in this dialog box can be completed.
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Set cutting property §|
[ ReOrder ” Rewerse H ReQrder ]
O ame ~ MO Mame
1 Elerment 1
2 Elementz
] Element3
4 Elerment4
5 Elements
& Elements
7 Element?
g Elements

a Elementd

10 Element10

11 Elernent11

12 Element12

13 Element13

14 Elemnent 14

15 Element 15

16 Element 16

17 Elemnent17

18 Element 1

19 Element12

20 Element20 P

z1 Elemnentz1

22 Elementzz ey

23 Elemnent23

24 Elemnentz4

25 Elementz5

26 Elerment 26

27 Elementz7

28 Element2g

29 Elermentza

30 Element3n
>

[#] showPath ﬂ M
Xl

1> show path
First check the “show path”, it will display the current graphics cutting order and the
cutting direction.

2> Manual sort

Select . This button is used to switch the current status of the operation is to edit or
view. Then you can marquee or click the graphics in the graphics display area (or click one

pixel or check many pixels). After selecting the graphic, select , these graphics to be

redirected to another list, to be processed as the first primitive. Primitives followed by
repeated operations, to complete sequencing of all graphics.

3> Change the direction of graphic processing
Mouse select the graphic in the graphics display area or in the list. And then click

Reverse

4> Change the cutting point
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Set cutting property

X

[ ReOrder ” Rewerse H ReQrder ]

O ame ~ MO Mame

Elerment 1

Elementz
Element3
Elerment4
Elements
Elementé
Element?

Ll B s T ) I SR SV

/ﬁ\\

Elements

a Elementd

10 Element10

11 Elernent11

12 Element12

13 Element13

14 Elemnent 14

15 Element 15

16 Element 16

17 Elemnent17

18 Element 1

19 Element12

20 Element20 e

z1 Elemnentz1

22 Elementzz e

23 Elemnent23

24 Elemnentz4

25 Elementz5

26 Elerment 26

27 Elementz7

28 Element2g

29 Elermentza

30 Element3n
>

[¥] showPath ﬂ M
Xl

Select the graphics that should be changed the cutting point, it will show all the nodes in
the current graphics. Select the starting point, double-click the mouse, it will change the

starting point of the current graphics. After the completion of all changes, click ,

the result of the changes can be saved.

In addition to cutting property features, the software also offers some tools to change the
cutting order, cutting direction and cutting point.

Click menu [View] / [ Show Path]

RDCANG. 0. 01
Layer Mode Speed MinPower | MaxPower  Oubput
] Cut 100.0 300 300 Yes
Export | General | Machine | Document | Manual | Info | Config
Path optimize
[ original or edit path [C]Enable rotate engrave
[Jorder of layer
Inside to outside Diameter{mm}:
Auto determine start point and dir
[ auto find start paint Circle pulse:
[Backlash reapy optimize
Block handle
Height: |50 Dir: |Up to batt »
O

Linefcalumn setup
Feeding Count:
% Mum: |1 wepaceimm): (0

Distanceimm}:
¥ Nurn: |1 space(mm): |0

Position: |SSGE NN v
Bestrewing breadth. .. E el

[ output select graphics

X

% (600,000 | 4 (611,724 | | (10000 <,

¥ 399,993 | mm I 394,035 | mm || 100.0) % a @

[ USE:Auta ] [ Start ”Pause,l’Continue” SaveTolFile ] —

[ Go scale ” Cut scale ] [ Stop ” Download ” UFileCutput ]

1> Manual sort
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Choose the primitive that should be changed the cutting order, then the cutting serial
number of the current primitive will display in the object properties bar.

% 138,959 | mm #¥ (93.622 | mm | [100.C) =, a Process MO
Y 64,179 |mm § 33.231 | mm | |100.C) % :H: 17

Enter the serial number directly in the processing number, then press the keyboard
“Enter” key, or click the plot area, the cutting order will be changed.
2> Change the processing direction

Click [Cut property] -> [Set Cut Direction] , to enter the edit mode of the cutting

direction. Then you can double-click on any position on the selected graphic.
3> Change the cutting point

Click [Cut property] -> [ Set Cut Point] , to enter the edit mode of the cutting point.

Then select the curve that should be edited, you can double-click on the node that you want
to set the cutting point to complete the change of the cutting point.

11.3.12.2  Setting And Editing The Cut In/Cut Out Lines

Drawing or importing curves, the curve is default not have any cut in/cut out lines.

If want to add cut in/cut out lines,select the objects, then click [ Cut property] -> [ Edit

cut in property] .The following dialog box is appearing.
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Cut in and out setting §|
Zuk in
[JEnable:
Line type:
Lengthdrmmm);
angleldegree):
Zuk auk
[JEnable
LineType:
Lengthdrmmm);
Angleldegres):
[ Ok, ] [ Cancel ]

To make cut in/cut out lines, first of all need to enable the cut-in/cut out function.
There are two types of the cut in/cut out lines: straight line and arc
Straight line cut in achieve through three ways:
a) Cut in with angle: cut in line and starting segment into a certain angle,
counterclockwise angle is positive

b) Cutin at center, the starting point of the cut in line is at center.

c) Cutin from center, the direction of the cut in line is from center to starting point,

and length is as setting.

Cut out line

o i —
Cut in line [ % I
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The arc length of cut in arc is as setting.

There are two types of cut in/cut out arc, as shown in the following figure

Female Male

The processing of setting cut out lines is same as cut in lines.

[1.3.12.3 Curve Smooth
For some less accuracy curves, this function can make curves more smoothness, and
processing smoother.

Click menu [Tool] -> [ Curve Smooth] , the following dialog box appears.

Curves smooth El

Smoothness J 5% I:‘ Direct smooth

| [ Apply HFuIIFrame” Ok H Cancel ]

Drag the smooth slider, and click buttonl Apply 1, before smooth and after smooth curves

will all show in the dialog.

The black curves represent the original curves, and the red curves represent after smooth
curves.
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Curves smooth El

Smoothness J 5% D Direct smooth

| ‘ [ Apply ][FuIIFrameH Tk H Cancel ]

You can view the graphics with drag mouse.
You can zoom in/zoom out the graphics with scroll wheel.

Click button [FullFrame] , graphics will shown in the dialog box for largest.

After get satisfied smoothing effect, click buttonl Apply 1, curves will processing smooth

according to smoothness settings.
Select “Direct smooth” , you can use another smoothing method.
The choice of smoothing method should be changed with the needs of the actual graphic.

11.3.12.4 Check Closure

Click menu [Tool] -> [Curve auto close] , the following dialog box appears.

Setting close error §|

Close error (mm):

Fu:-ru:e to close

cancl

Close error: When distance from the starting point to ending point less than close
tolerance, automatic closing of the curve.
Force to close: Mandatory closure of all selected curves.

11.3.12.5 Remove The Overlap

Click menu [Tool] -> [Delete overlap] , the dialog box appear.
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Delete owerlap lines §|

[ |Enable overlap error

Cwerlap errar{mm): I:I

| ik, | [ Cancel ]

Under normal circumstances do not select the “Enable Overlap error”. Removing the
overlapping lines when two lines are compared to a good degree of coincidence. If you need
to delete overlapping lines, you should select “Enable Overlap error”, and set overlap error.
Generally do not overlap error set too large, so as to avoid accidental deletion.

11.3.12.6 Combine Curve

Click menu [Tool]l / [Combine Curve] , the following dialog box appears.

Settaing combine error §|

Combine error{mm):

[ ok, l [ Cancel ]

The software automatically merge curves in the selected curves, when these curves
merge tolerance is less than the setting of combine error.

[1.3.12.7 Bitmap Handle

Select a bitmap, then click menu [ Tool] -> [ Bitmap handle] ,
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Bitmap handle

Width: 500 Pixels
Height: 750 Pixels
H Resolution: Pixelsfinch
Y Resolution: 96 Pixelsfinch
Brightness: 0.0%
-
3
Contrast: 0.0%
E

[Jinvert color

[[]set output resolution

Resolution{pixelsfinch) |“©

[pither
Net araphic
Dot
Blac
Gray
Sharpen

[ Apply to view ] [ Apply to source ]

( Get outline |

| I [ Save as ][FullScreen“ Ok ][ Cancel J

In the top right of the dialog box displays the information of the current image.
Be noted that, the horizontal resolution and vertical resolution is changing with drag
scaling.

[ Apply to view] : Current settings is only used for preview, without affecting to the
original bitmap, press button [ Cancel] , bitmap will returned to the state of original image.
Therefore, only use for adjust effect. However, this approach requires more time and memory
Space.

[ Apply to source] : Current sttings is use for orginal bitmap directly, so even finally
click button [ Cancel] , image will also unable to return to the original image. Therefore, it
mainly used in multi-step operation, and the current operation of this step is necessary to do,
such as general pictures must be transformed into grayscale. This can save the computing
time of the follow-up operation.

[ Save as] : Retain the results of the previous operation, In addition to using [ Apply to
view] can also be exported. On this basic, to facilitate subsequent processing.

[ Gray scale] Generally, other image processing is based on the grayscale, so before
handling, you can do a grayscale processing, then click button [ Apply to source] . For the
grayscale than the color image occupied smaller memory, for large image step by step handle,
to a certain extent to avoid the lack of memory.

For color image, adjust contrast and brightness, have some auxiliary effect to following
dither processing.
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Adjust contrast:

Before processing
Invert:

Sharp:

Before processing After processing

There are three method for dither processing: Net graphic. Dot graphic. Black and white

1> Net graphic
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Net graphic need adjust net size, better suited to material which is not high resolution,

or the laser is relatively slow to respond.
To get the appropriate net size, you can adjust resolution and net frequency of the image.
The higher resolution, the more delicate.
The higher net frequency,the smaller net size.The lower net frequency, the bigger net size.
Generally, resolution of image is 500 - 1000, and net frequency is 30-40lines.

2> Dot graphic
Dot graphic performance of good grayscale, better suited to material which is high

resolution, and the laser responds fast.

3> Black and white
In most cases, the effects of color image into black and white image is poor,, however, for

some clear outline image, is very easy to use.

él#}ta.t% ﬁﬂﬁ éFF}ta_I:% ﬁﬂﬁ

Get outline:
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Bitmap handle

X

Width: Pixels
Height: Fixels
H Resolution: Pixelsfinch
W Resolution: Pixelsfinch
Brightness: 0.0%
-
3
Contrast: 0. 0%,
:

[CJirvert color
[C]5et output resolution

Resolution{pixelsfinch) I:l

[ oither

et graphic

I

Dot graphic
Black And White
Gray scale

Sharpen

’ Apply bo view ] [ Apply to source ]

[ Get outline l

| [ save s |[Fulscreen [ ok [ cancel |

Click “Get outline” button to extract the contour graph. As following picture

[1.3.12.9 Processing preview.

Click menu [Preview]

A

Z

o
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Ml Preview EE
el 365.7mm,108.2mm
Toticll fim 0:01:34.043
Light tine 0:01:17.180
Tdle interval 1686.3mm
York interval 7718.0mm

Position 0.0mm,0.0mm
Sneel 0.0mm/s

&
<
<
-
(=
(=]

Software supports the preview of the documents to be processed, and you can get some basic
information through the preview. For example, the path of the actual output of the processing,
general processing time, processing the distance. The machining process can be simulated.

In addition to the current edited file preview, you can also preview the files have been
saved as rd.
1> Preview rd file:

Double-click in the graphics display area. Choose the graphic you want to preview in the
pop-up dialog box. And then open

Open RIX
Laaok jn: | (L) My Documents L T M-
) Adobe Scripts My eBooks (3 5ource Insight
) Baidu My 150 Files CaYisual Studio 2008
)Corel User Files jMy Music o 1= o
(AFILTERIT4 User Settings JMy Pictures
CakSDStore My Q0 Files
My Designs My W'ebs
£ >
Files of twpe: | *1d w

[] Open as read-orly

2> Software also supports to set the parameters of preview
Right-click Anywhere in the graphics display area, the configuration menu will appears.
Select “Config” , pop-up following dialog box
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Full window
Config

Horizontal mirror

Vertical mirror

Configuration

Background
Back color:

Draw coloriPower)

0%

Simulate color{Power)

0%

Idle color

anchaor

() Top left
) Botkom left

%]
N

Font color:

T W oo

e

) Top right
() Bokkom right

You can preview the color of graphics to match the actual output of energy. Users can
easily view whether the layer energy is true.

Il Chapter 4 System Settings

Before output graphics, required to determine whether the system settings are

correct.
[1.4.1 Output Setting

Expork

General | Machine | Documenk

Path optimize
[ ] criginal or edit path
[ ] order of layer
Inside ko outside
Auto determine skart point and dir
[ ] Auto Find stark point
[ ]Backlash reapy optimize
Block handle

Height: |50 Dir: |Up ko batt »

Linefcalumn setup
% Murm: |1 #space(mm): |0

Y Murn: |1 Yspace(rnm): |0

Marual

[ ]Enable

Info

Config

rokate engrave

Diameter(mm):

Circle pulse:

[

Feeding Counk;

Distancelmm);

Iyl

Poasition:

Bestrewing breadth. .. |

11.4.1.1 Path optimize
1> Original or edit path
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Selected by the original path or edit the path, press the original drawing graphics output
to the machine processing the order.

If the order by layer, from inside to outside and other optimization methods are useless.

Generally do not choose the property; in a very large number of graphics output, the
choice of this property without having to wait for the software algorithm processing time.
2> order of layer

The list from top to bottom layer by layer order, followed by the output layer to the
machine processing.

Generally do not choose to (not in front of check) by order of the output layer.
3> Inside to outside

If there are other graphics within the closed graph, then the first cut and then finished
cutting all the graphics inside the closed graph.
4> Auto determine start point and dir

If not checked, then do path optimization, only adjust the order of graphics processing,
cutting starting point and the cutting direction to remain at the original graphics processing
5> Auto find start point

Using the change function, the graph from the closure point to find a more ideal start
cutting. For special processes, such as cut glass, choose this, in general, do not choose.
6> Backlash repay optimize

When the machine there is space (such as dislocation of the seal cutting graphics), can be
checked, in general, do not choose.
7> Block handle

Block height for the different graphics to set a different height values, there is no rule for
the arrangement of the graphics, height generally between 10-20mm set.

Block processing needs can choose the direction from top to bottom, from bottom to top,
from left to right or right to left.

For a regular arrangement of graphics, if you want to achieve the desired cutting
sequence, you must set the appropriate height. Generally high altitude take a single line graph,
as the block height.

[1.4.1.2 Array Setting
Array processing setting is facilitate used to treatment array processing of graphics.

X Num and Y Num, correspond to the rows and columns of the array

X Space and Y Space, correspond to the rows spacing and column spacing of the array.

represent the distance of the graphic edge.

[4F]

Adjust the X space, Y space more closely the graphical layout, click the plot area, so that
graphics are not selected, then the arrow keys on the keyboard to adjust, and roll the mouse
to display the zoom, so the adjustment interval process more accurate.

represent the distance of the two graphic center.

Bestrewing Breadth Setting :
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According to the size of frame and current array settings, to determine the maximum
number of columns(X Num) and rows(Y Num).
Click button Bestrewing breadth, the following dialog box appears:

Bestrewing breadth E

¥ breadth(nm): m

T braddth(mm): (300

canct

Click OK, software can automatically calculate the appropriate numbers of rows and

columns.
[1.4.1.3 Rotate Engraving

[ Enable rotate engrave] : After enable engraving, the actual precision of Y-axis will

be based on diameter and step per rotate to auto match the setting of pulse precision of
Y-axis. In addition, the work area in the main interface will also change.

[ Diameter] : The diameter size of the parts.

[ Step per rotate] : The number of pulse corresponds to the workpiece rotate one week.

The function is to facilitate the users to replace parts, and different size of the workpiece
when the workpiece is not very different before use. When the relatively large difference in
size of the workpiece, it is recommended to use directly modify the motor step approach to
implementation.

Rotary engraving is only when using the rotation axis to replace the Y-axis use.

[1.4.1.4 Feed Setting

To use the feed, must first enable the feed.

After set feeding parameters, the shaft will be feeding a feeding length, and repeat the
process , until the times of processing reach to number of feeding.

If the machine is not equipped with feeding devices, in general, enable the feed ban.

[1.4.1.5 Position

Setting the laser head back location after processing completed.(Current position.

Original anchor. Machine Zero.

Current Position : Laser head back to the position before processing.
Original anchor : Laser head back to the last anchor ,the anchor may set at panel.
Machine zero :  Laser head back to the zero of the machine.
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[1.4.1.6 Output select graphics
After check Output select graphics, then only output the selected part, rather than not

output the part not selected.

11.4.2 General settings

Export | General | Machine || Document || Manual || Info Config

amall circle speed limik Scanning(Reverse interval)

Diameter(mm)  Speedimm)s) Speedimrm)'s) Reverse int. .,
£ > £ b3
| add. || opelete | | add. || el

[1.4.2.1 Small Circle Speed Limit
On processing work, the software automatically determine whether the current round

need to limit speed ,then according to the diameter size of the circle to determine the speed.
If parameter configuration appropriate ,will greatly enhance the quality of small round. Click

button [Add), [Delete]l , [Modify] to configuration.

Small circle is less than speed of the rules limiting the list of small round circle of
minimum radius, minimum radius circle at the speed of the output of the corresponding.

If the speed greater than maximum speed limit list the speed round, the speed only
associated with the speed of the layer.

If the speed is in the list, set the output speed by list.

If the request received by limiting layer parameters faster than the speed set in the layer,
press the speed of the output layer.
[1.4.2.2 Scan backlash

Laser scanning graphic way, because the relationship between the machine belt tension
may cause the edge of the scanned graphics uneven. Therefore, increasing backlash to fix. It
has the specific backlash for the certain speed. General, the greater the speed, the greater the
backlash.

O Add backlash

Click the Add button, the screen will pop up as shown in Figure
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X]

Speedimm)'s)

Reverse intervalrmm) |03

[ ok | [ Cancel ]

Set speed and backlash, click OK, the value to be inserted into the list of backlash.
2 Modify backlash

Double-click the left mouse button scanning (reverse gap) need to modify the reverse
block entry clearance, then the pop-up screen shown in Figure.

X]

Reverse intervalimrm)

[ ok | [ Cancel ]

In the interface can modify the current speed of the corresponding backlash.

(3 Remove backlash
Right-click scanning (reverse gap) block in the backlash to delete the item, then click the
[ Delete] button.

[1.4.3 Machine parameters

Export || General | Machine |D|:u:umenl: Manual | Info || Config

E| Cut parameters ~ e
Idle speedirmm/s) 300,000 Axis x Mirror
Idle Accimm)s2) Z2000,000 Axis Y Mirror
Skart speedimm)s) 15,000 —
Min Accimms2) 500,000 Laser head
Max Accimm)s2) 2000, 000 © O ®
Cutking mode Mormal Cukking © O O
Acc Mode S mode © OO0
Sweep parameters
® Start Speedimm/s) 20,000
 Start Speedimmis) 15,000 < [ ]absolute coordinate
| |
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[1.4.3.1 Cut parameters

= cut parameters
Idle speed(mm),s) 300,000

Idle Accimm)s2) 2000.000
Start speed(mmfs) 15,000

Min Accirmmfs2) 500,000

Max Accimmfs2) 2000,000
Cutting rmode Marmal Cutting
Acc Mode S mode

Idle speed: this parameter decides the max. speed of all lines not emitting beams during
the operation of the machine. This parameter should not be lower than the lower of the
jump-off speed of the X-axis and that of the Y-axis and not exceed the higher of the max.
speed of the X-axis and that of the Y-axis, if the setting is illegal, the controller will
automatically set this parameter within the range above; a comparatively high idling speed
can shorten the operation time of the entire figure while excessively high idling speed may
cause dithering of the tracks, therefore, you should take all relevant factors into consideration
when setting.

Idle Acc: Corresponds to the acceleration of the speed of air travel time, air and
air-way-way speed of acceleration to match, if you set too slow the actual speed may not
reach the air-way set value, if set too fast, they may not withstand the mechanical structure,
resulting jitter . Slightly higher than the general acceleration of air-way cut acceleration.

Cutting Acc: Corresponding to the acceleration of the speed of cutting (cutting speed is
the speed of the layer parameters of the layers).

Turning speed: Turning the corresponding deceleration in the cutting process, the
minimum speed of the drop, when processing a lot of teeth when the graphics may be
appropriate to reduce the turning speed.

Turning Acc: Should match with the turning velocity.

Cutting mode: Split precision cutting, fast cutting, ultra-fast cutting, the user can choose
according to the actual applications. Such as the emphasis on accuracy, select the precision

cutting, such as emphasizing speed, select the fast cutting.

Acce. mode: this parameter decides the acceleration and deceleration mode (S mode or T
mode) of the motor during operation, the motor accelerates and decelerates slowly and
smoothly in the S mode and fast and relatively unsmooth in the T mode; the default mode is
the S mode.

1.4.3.2 Sweep parameters

= Sweep parameters
¥ Start Speed(rnmfs) 20,000
y Start Speedi(mmfs) 15,000

¥ Accimm)fs2) 2000.000

y Accimmyfs2) 2000,000

Lire Shift Speed (rm, 150.000

Scan Mode Cornrnon Mode

Facula Sizel50-~99%:) 98,000

x Start Speed, y Start Speed: Off scanning speed in the use of stepper motor drag, do not
began to accelerate from 0, but can start work directly from a speed to shorten the overall
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processing time, but the speed is not too high, and because the X, Y axial load is different
from the rate, general the initial speed of X-axis slightly higher than the initial speed of
Y-axis

x Acc, y Acc: With the scanning speed (the speed of layers in the layer parameters) to
match, if set too small, the scan speed to a longer distance, the scanning efficiency. The
machine can be set according to the actual structure, load conditions vary. Since X, Y axis
load, generally much higher than the X-axis Y-axis accelerometer.

Line shift speed of scanning: this parameter is specially used to control the max. speed of
the scanning to shift vertically from one line to the next line below it. If during the scanning,
the line space is too large or the block space is too large when scanning block figures while
precise positioning for each line or block is required, you can set the line shirt speed of
scanning to a comparatively low value. This parameter cannot be less than the jump-off
speed of the corresponding axis during the line shift and cannot be higher than the max.
speed of the corresponding axis during the line shift, if the setting is illegal, the controller
will automatically set this parameter within the range above.

Scan mode: There are two modes for your selection: the general mode and the special
mode, in the general mode, there’s no any treatment during the scan, in the special mode,
light spots will be treated. If the special mode is activated, the power of the laser should be
increased and correspondingly, the light spot percentage will be lower and the laser power
attenuation will be higher, to achieve the same depth of scanning, the laser power should be
higher. The purpose to select the special mode is to make the laser to emit beams at high
power and in short period, during deep scanning, the effect of flat
bottom can be achieved, however, if the light spots are improperly adjusted, this effect may
not be achieved and the working mode of high power and short period may influence the
service life of the laser. The default mode is the general mode.

Facula Size: When scanning the general pattern of selection, the argument is invalid,
when you select a special mode, the onset of the parameters. Control the parameters of
control in 50% to 99%, respectively.

11.4.3.3 Home parameters

(=] Home para
Horne speedimmm,/s) 80,000
Auto home X Yes
Auto horme Y Ri=3
Auto home z MO
Auto home U [Wa]

Home speed: This parameter determines the machine is turned back to the origin when
the speed of a larger format if the machine can be set to reset the speed is too large, but not
too much.

X, Y, Z, U Auto home: The axis can be set whether should reset at boot time.

[1.4.3.4 Go Scale parameters

=] Go Scale para
G0 scale mode Close laser
Go scale blankirmm) 0,000
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Go scale mode: Points of light to go off the border, the opening cut borders, corners
three modes.

Go scale blank: Walking frame can be based on the actual image size up and down again
about the direction of some of the white left side of the border in order to ensure complete
contains the actual graphics.

This setting is on the control panel to go with the border-related functions, while walking
on the border with the independent software.

[1.4.3.5 Other parameters

=] Other parameters

Array processing Bi-dir Array
Return position Ahsolute Origin
Delay before feed(s)  0.000

Dealy after feed(ms) 0,000

Forcus depthrirm ) 0.000

Backlash ¥{rmm) 0.000

Backlash " (rnrm) 0.000

Array mode: you can choose the swing mode and the one-way mode. The Swing mode:
cutting the array back and forth in order; the One-way mode: always cutting the array from
one direction to another. If One-way mode is selected, all array units have the same
movement modes and the same liquidity of movement, however, this mode will take more
time than the swing mode. The default mode is the Swing mode.

Return position: You can select the locating point and the machine origin. This
parameter decides the position, the locating point or the machine origin, where the laser head
stops upon completion of each operation.

Delay before feed: Using the feeding device, the delay before a single feed, users can
arrange the time and the like, such as picking process.

Delay after feed: Refers to the material sent to the feed device in place, the need for
stability after a period of time for processing.

Focus depth: Auto focus operation to find the corresponding panel.

Backlash X, Y: Used to compensate the backlash caused by the machine drive problems.
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11.4.3.6 Axis Mirror

RD5. 0. 0. 8 3
A E
Layer Mode Speed MinPower  MaxPower  Oukput mm H mm i a @
W mm I i o
Y-
[ Up ] [ Diown ] .
Export | General | Machine | Document | Manual | Info | Config .
Cut paramekters ~ (545 ey .
Tdle speed{mm)'s) 300,000 Ais ¥ Mirror .
Idle Acc{mm/s2) 2000,000 Axis ¥ Mirror
Skart speed{mm)'s) 15.000
. Laser head
Min Accimm)s2) 500,000
Ma Acc{mmmy's2) 2000,000 O 0O ®
Cutting maode Marmal Cukting © OO D
o O O O
Acc Mode S mode
=l 5wweep parameters
% Start Speed{mm/s) 20,000
[] absolute coordinate
v Start Speedi{mm/s) 15,000 w
| | Auko hd [ Go scale ] [ Stark ”Pause,l'Continue” SaveTolFile l ot
ol
[ Find Com l [ Cut scale ] [ Stop ” Dovnload ” UFileCutput l

Generally, Axis direction of mirror is based on the actual location of the limit or home of
machine.

The default coordinate system if Descartes coordinate system, and zero in the bottom left.
If the zero point of the machine is top left, then X-Axis do not need to mirror, but Y-Axis
need to mirror. If the zero point of the machine is top right, then both X-Axis and Y-Axis are
all need to mirror.

More convenient way is to view the graphical display area if the location coordinates and
arrow on your machine the actual position of the same origin. If not, then modify the
direction of the mirror. If the arrow appears in the upper left corner coordinates, and the
origin in the upper right corner of your machine, you just need to check both the X mirror.

11.4.3.7 Position of Laser Head
Position of Laser head means the location laser head relative to the graphic.

|
@ @ @
ole ele a0

Top Left Top Middle Top Right
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92 wWos W
] 0]~~~ ov 00
|
Middle Left Center Middle Right
V5 W9 W
o0 00 00
I
Bottom Left Bottom Middle Bottom Right

when you intuitive view, just look at the zone where the green point appears.

[1.4.3.8 Absolute Coordinate

You can directly check this option when you want the graphics location in the graphics
display area correspond to the actual work location of processing. Then the graph position
will no longer relate with the actual output position of the laser head and orientation point,
but always regard mechanical origin as the anchor point.

I1.4.4 Document Management
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Export | General | Machine | Document | Manual | Info || Config

Mumber File Mame Timne(H:1M:5:MS)

Delete
Delete oAl
Dawnload

Upload

Read

Process

Zal kime

1> Read
Click button Read, the software will communications with the controller, read the list of

files on the controller.
After read controller successful ,file information will be displayed in the document list.
2> Download

Click button Download, will pop up the file dialog , select *.rd downloaded file, then the

file will be downloaded to the controller.
If the download is successful, the document list will update.
3> Process
Select the file to be processed from the document list ,and click button Process

The controller will start the specified document.
4> Delete
Select the file you want to delete from the document list, and click button Delete

The controller will delete the specified document.

If the deletion is successful, the document list will be updated.
5> Delete All

Automatically remove all file in the controller, and update the document list.
6> Cal time

Motherboard supports processing files towards hours worked. Select the file to calculate
the work hours worked and click the button. Calculation to be completed, the control panel
will be prompted to complete the calculation. And then point to read button shown in the list,
calculated from the working hours.

In addition, when the document processing operation performed, the hours information
will also be covered by the actual processing work.
7> Upload

Upload the selected file which is on the motherboard to PC.

72



User’s Manual of Laser Engraving / Cutting software

I1.4.5 Manual

Export | General | Machine || Document | Manual | Info Config

Current Position | | =
Y=7
=7
Bxis Mowe
OFfset{mm); |10.000 [ IMarve Fram origin
Speed{mm)s): |50
Poweri%): |0 []1F Light
Y+ £+
‘ *- ‘Hnme ‘ n+ ‘ Hormne
- zZ

Axis control, can only control one axis each time. You can set the information for axis
move, including move length. speed. laser on-off and laser power.

If you check “Move from origin”, then the offset you set means the offset to machine
zero.

If you not check move from origin, then the offset means the offset to the current
position.

The X-axis, for example, assuming the current position is 100mm, such as the step
distance is set to 10mm, then the exercise once, the new location will be 110mm, such as the
check moves from the origin, movement time, the new location will be 10mm, and repeated
Movement, location will no longer change.

Note: According to the provisions of the controller, the absolute position is no
negative in the whole breadth. If you check the Move From Origin, and set the offset
value negative, then the machine will hit limiter.

73



User’s Manual of Laser Engraving / Cutting software

[1.4.6 Info
Information on the operation of the motherboard manufacturers need to enter password to
view parameters.

Export | General | Machine | Document || Manual | Info Config

Tokal on timedhour min:s):

Total processing timelhour :min:s);
Previous processing timel hour:min:s:ms);
Tokal laser on timelhour :min:s):

Tokal processing times:

* Taokal kraval(m):

% Taokal kravel(m):

Mainboard version:

1> Total on time: The total time of motherboard working

2> Total processing time: The total time of processing ,including the time of jump moving.

3> Previous processing time: The time of the last processing

4> Total laser on time: The time of the laser processing

5> Total processing times: The number of completed processing, not include the processing
forcing to end.

6> X total travel: The total travel of motor X.

7> Y total travel: The total travel of motor Y.

Motherboard version: The version of the current controller.

The function of upgrades:

If the board has additional features, the manufacturers will provide the update file  (*.
bin format), the user can load the upgrade file to upgrade the motherboard. After the upgrade,
you need to click on the control panel "Reset" button reset the motherboard before normal
use.

Export | General | Machine || Document | Manual | Info Canfig

vendor passward;

Mainboard version:
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Il Chapter 5 Processing Output

[ IISE: Auko ] [ Start ”F‘ause,l'Cu:untinue” SaveTolFile ]

[ Go scale ” Cut scale ] [ Stop ” Dowenload ” LIFileCukput ]

[1.5.1 Device port
Software supported two ways to link motherboard: USB and Earthnet.
Users click the Device port button, and set link type and port in the pop-up dialog.

(%) UsE: Auto w ||

1 wieb:

Default IP;

USB:

If the computer only connected one device, you can set to Auto. The software will
automatically search the device.If the computer connected many devices, then first of all you
need to click [ Search ].After search, the connected devices will all add to the drop-down list.

What you need to do is select the specified device.
Earthnet:

If the computer only connected one device, you can set to default. If the computer

connected many devices, all you need to click [ Search] .After search, the connected devices

will all add to the drop-down list.
11.5.2 Go Scale, Cut Scale

For Example Go Scale, As the following figure shown, the actual graphic is round, and
the red rectangle outside the circle is the smallest rectangle, click button Go Scale, laser head

will run once along the rectangular path.
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For Example Cut Scale, As the following figure shown, the actual graphic is round, and
the red rectangle outside the circle is the smallest rectangle, click button Cut Scale, laser
head will be cut along the rectangle.

[1.5.3 Start, Pause, Stop, SaveToUFile, UfileOutput, Download

Start: Output the current graphic to the machine for processing.
Pause\Continue: Click Pause, will stop the processing work, click the button again to
Continue
Stop: Stop the current processing work
SaveToUFile:

Save current file as RD format, using for offline processing (Can be copied to other
memory board for full offline operation).

UFileOutput:

Output the offline file (RD format)
After save offline file, click UfileOutput to select rd file to processing.

Download:

Download the file to the memory of the controller , then user can start the file through the machine panel.

[1.5.4 Layer Setting

Layer Mode Speed MinPower  MaxPower  Qukpuk
[ ] Cut 100.0 30.0 30.0 Yes
[ ] Cut 100.0 30.0 30.0 Yes
[ ] Cut 100.0 30.0 30.0 Yes

Cut 100,10 30,0 30,0 Yes
[ p ] [ Do ]

Double-click the layer that you want to edit in the layer list, layer parameters dialog box
will pop up. Layer parameters in two parts, part of the common layer parameters, namely,
how both types of processing layers, the layer parameter are valid. The other part is the
proprietary layer parameters. Namely, when change the layer type of processing, the
corresponding parameters will change.
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Layer Parameter EI
AN | Load parameters From library |
I
Layer: _
Is Oukput: |§EE hl
Speedimmis): | 100 [ ]Default
If Blowing: | Yes b

Processing Mode: | Cut L

Min Power{%s) Max Paower(%s)

Laserl: |30 3n [ Default

LaserZ:

Seal; (0.000 mm

Open Delay: |0 ms

Close Delay: |0 ms

Through mode

=~ [ ik, ] [ Cancel ]

[1.5.4.1 Common Layer Parameters Setting

Layer: | N
Is Qutput; M
Speedimmjs): | 100 [ ]Default

If Blowing: | vYes -

Processing Mode: | Cut -

Min Power{%) Max Power ()

Laserl: |30 30 [ | oefault

Laserz: |30 30

Layer: Software use layer to distinguish processing graphics parameters of different
layers. The scan processing methods, a number of the bitmap in the same layer, the overall
output as a picture, if you want to separate out all the bitmap, the bitmap can be placed into
different layers.

Is Output: There are two options: Yes and No. Select Yes, the corresponding layer will
be exported for processing; Select No, the corresponding layer will be not exported for
processing.

Speed: The speed of laser processing.

In terms of cutting speed, the better the processing effect is and the smoother the track is;
the faster the speed is, the worse the processing effect is;
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On the scanning process, the more slowly, the same energy the deeper the next scan, scan
traces thickening, scanning resolution accordingly reduced. Faster to scan the same energy
the more shallow depth, detail distortion increases.

On the dot process, the main change is the speed of moving air.

If you check the "default”, the actual speed of the speed set by the panel to decide.

Is blowing: If the machine add a fan, and fan has been enabled, then if the selection is
"Yes", then when processing the layer, it will open the fan, otherwise, will not open fan. If the
fan is not enabled, you either select "yes" or "No", are meaningless.

Processing mode: Processing mode, meaning the mode to process corresponding layer.

If you select vector layer (color layer) currently, there are three options: Laser scanning,
Laser cutting and Laser dotting;

If you select bitmap layer (BMP layer) currently, there is only one option: Laser scanning.

Laserl, Laser2: Laser signal corresponding to the board 1 channel and 2-way laser output.
If a single head machine, the first 2-way laser meaningless.

Min power, Max power: The range of power value is 0~100, it means the intensity of laser
during the process; the higher the value is, the stronger the laser is, and the lower the value is,
the weaker the laser is.

Processing for different types have different meaning.

The cutting process, the actual power is compared with the cutting speed to follow, the
speed of low energy is also low, high-speed energy is high, so as to ensure the energy evenly
throughout the cutting process. Therefore, the speed of minimum power corresponding to the
lowest energy, the minimum speed is usually 0, but if you set a minimum speed of take-off
speed of the take-off speed; maximum power corresponds to the layer speed.

How to set proper Min power and Max power:

If the laser is too strong during the whole process, you should set the minimum and
maximal power lower, otherwise, set them higher;

If the laser is too weak in some places during the process, you should set the maximal
power higher;

If the laser is too strong in some places during the process, you should set the minimum
power lower.

If it is cut through, the minimum power and maximum power was no significant
difference can be set to the same.

On the scanning process, general scanning, minimum power and maximum power must
be consistent. Carving slope, the minimum power corresponds to the top of the slope of the
power, maximum power corresponds to its base of power.

Minimum power is top of the partial width is too small, the details at the Resolution
unclear.

Minimum power is too large then the slope is not obvious.

L

/

On the laser dot process, the minimum power and maximum power can be set to the
same.
If you check the "default”, the actual power to set the power from the panel to determine.

Top

Bottom
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Click the button "Advanced", you can also set other layer parameters.

Other layer parameters @

[ ]Enable pen up and down

mm

i

Speedimm)'s):
Paink
Dot interwvalls) 0
Enahle Laser1
Enable Laserz
| Ok, | [ Cancel

Pen Up and Down:

If the machine has been installed lift platform, and requires a high degree on different
platforms for processing, you can the function of Pen up and down.

This position corresponds to pen up is the height at which the platform for processing,
carrying the pen position is empty, take the corresponding before, the platform should be
moved to the laser head height which then pan will not produce interference with the
workpiece to be processed. If the pan does not confirm the laser head to produce interference
with the workpiece to be processed, you can not lift the pen position set.

Method:
1> Enable pen up and down.
2> The position of pen down: Manual control panel key mobile platform to be graphic
processing Graphics processing plane, adjusting the focus. Then the button “read", you
can set the position of pen down.

3> The position of pen up: Manual control panel key mobile platform, move to the laser

head does not interfere with the workpiece height and moving the laser head through
the panel button to confirm no interference, click the button "read", you can set the
position of pen up.

Dot:

Dot here is specifically for the point drawing tools to draw primitives, or imported from a
dxf file, point primitives. And independent of the current way of processing layers, namely,
whether the current layer is cut or a scan, pixel graphics of the dot to dot mode is always
output.

The speed of dot is the speed of layer, and the energy of dot is the maximum energy of the
layer.

Enable laser:

When the machine is equipped with two lasers, under normal circumstances, is two
simultaneous output

However, users can also be enabled by setting the laser to make them all the way is not

outpu.
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11.5.4.2 Laser Scan Parameters Setting

Layer Parameter @ Layer Parameter @

L [ Load parameters From library l Fas [ Load parameters fram library l
| .
Lavet: _ N Laver: _
Is Output; | Yes v Is Qutput; v
Speed{mms): |100 [ oefaul: Speed(mm|s); |100 [Joefaul:
If Blowing: |Yes w If Blowing: |ves “
Processing Made: | Scan v Processing Mode: |Scan w
Min Power(%) Max Power(%) Min Power(%) Max Power(%s)
Laserl: [30 30 [ oefault Laserl: |30 0 [ oefault
Laserz: Laserz:
|:| Megative Engrave |:| Cptimized Scan
[ independent oukpuk [Joutput direct [ 1ndependent output
[Iramp Effect
Ramp Length: T Ramp Length: ]
Orerstriking: |Un-process % Owverstriking: |Un-process
Scan Mode: | ¥_swing b Scan Mode: | ¥_swing b
Intervalimmy: |01 Inkeryal{mm): |01
~ [ ok ] [ Cancel ] ~ [ ok ] [ Canicel ]

The left side of the dialog box to set the parameters for the vector scan, the right of the
dialog box, a bitmap scan parameters.

Scan of the vector data do not support Negative Engrave, Optimized Scan, Output direct.

Negative engrave: If you do not select Negative engraving, the black dots which run across
the bitmap will emit laser and the white dots which run across the bitmap will not. If you select
Negative engraving, the white dots which run across the bitmap will emit laser and the black dots
which run across the bitmap will not.

Optimized scan: If you select Optimized scan, it will adjust users’ setup of Scanning
interval automatically to the best values and optimize the scanning effect. Otherwise, we
should select Scanning interval as set by the user for scanning. We generally select the
Optimized scanning.

Output direct: On the grayscale bitmap, grayscale graphics for the actual output, where
both the deep color of the laser energy, laser energy where light color small.

Ramp effect: If you select Ramp effect, it can make the track edges of scanned figures
presented as ramp in order to attain solid effect.

Overstriking: Includes Un-process, Intaglio and rilievi. General select Un-process.

Scan the font is the font that is part of the scan, which is the font intaglio.

Scan the bottom of the bottom part of the scan, which is the font rilievi.

Note: select the ramp effect, set the font bold choose not to deal with. Otherwise, it
will affect the ramp effect.

Font intaglio: the text does not have the outline border. It is the text itself that is to be

scanned, please see the figure below: We | COMeE

Font rilievi: The text has the outline border, it is the figureal base to be scanned, please

Welcome

see the figure below:
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Scan modes: including X_unilateralism, X_swing, Y_unilateralism and Y_swing.

X _unilateralism: The laser head scans figures back and forth at the level direction, but only
emit laser toward one direction. For example, the laser head emits laser when scanning from
right to left, but not emits laser when scanning from left to right.

X_swing: The laser head emits laser and scans figures back and forth horizontally.

Y _unilateralism: The laser head scans figures back and forth vertically, but only emit laser
toward one direction. For example, the laser head emits laser when scanning from
the top down, but not emits laser when scanning from the bottom up.

Y _swing: The laser head emits laser and scans figures back and forth vertically.

Note: We generally adopt the scanning mode of X _swing.

Interval: The interval between the current line and the next line to be scanned by the laser
head. The smaller the interval is, the darker the scanned figures is; If reverse, the weaker.

Recommendation: @ The scanning interval is set below 0.1mm for vector layer (color

layer) in general. & The scanning interval is set above 0.1mm for bitmap layer (BMP

layer) in general, and then the Minimum power and Maximum power should be
changed to attain the perfect effect of the scanned figures.

[1.5.4.3 Laser Cut Setting

lLayer Parameter @

FAN l Load parameters from library l
I
Laver: [
Is Qukpuk: W
Speedimmysy: 100 [ ]Default
IF Blowing: | e 3 Seal cutting has not

closed the graphics
Processing Mode: | Cut W grap

appear the case is closed,
Min Power(%) Max Power(%:) you can compensate with
Laserl: |30 30 []Default ,| the seal to close, butif the
seal is misplaced, you can
not compensate, you can

Laserz:

Seal: |0.000 o use 4.9.5 optimization
<
Cpen Delay: |0 L= || Opendelay
Close Delay: |0 .

A\ 4

Close delay

g

=~ Ol ] [ Cancel ]

Through mode
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Using the slit width compensation can compensate for the offset between the graphics
and the actual output graphics that caused by laser cutting.

It only has effective for the closed graph.

Direction: Compensation direction is set according to actual needs, such as cutting a
circle, if you want to retain the cutting down of the circle, you should set out the direction of

compensation; If you want to keep the hole should be set to compensate for the inward
direction.

Sew width: it is the width of the laser.

Other cutting param E|

[]Enable sew compensation

Direction:

Sew width T

| ok | [ Cancel

[1.5.4.4 Laser Dot Parameters Setting

Layer Parameter §|
Layer: [ R
Is Qukpuk; | Yes 7
speedimmysy: |100 [ ] Default
If BElowing: | ves -

Processing Mode: | Dok -

Min Power{%) Max Power{ %)
Laserl: |30 a0 [ ]oe

The time for emitting laser on
one dot during the process. The

/' higher the value is, the darker

Dot ke |01 5 |

The interval between the dots
Dot interval: | /mn'
I

Dot length, for cutting dash line

o Centaujot,p\} |

Only dot at center

Laserz; |30 30

Dok length: |0 _ L P

Ok ] [ Cancel ]
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Il Chapter 6 FAQ

I1.6.1 After start processing, the machine does not move or disorder or loss
part of graphics
€ Check whether the graphic data is out if frame. The data beyond of the frame
will not be cut.
€ Check the setting of Laser head position.
[1.6.2 Software automatically shut down when import file
If the operating system is XP, please check if the patch is installed.

11.6.3 Machine panel prompt [Less buffer distance]

€ Check the engraving speed in the machine parameter, generally, the engrave
speed no 8000
€ Ensure that graphics are not close to the border of the machine frame.

[1.6.4 Processing graphics sis mirror to the actual graphics

Check “Axis Mirror” in the General settings dialog(See: 4.2 General settings )
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lll User’s Manual of Laser Engraving
Cutting Software LASER__WORK
RDCAMG6.0

Il Chapter 1 Overview

[11.1.1 Laser engraving cutting system introduction
Laser engraving cutting system through a computer numerical control machine tools to
achieve effective control, according to the user’s different requirements of the completion of

processing tasks.

The system including control board and control panel, and supporting software. This
manual describes how to use the software to complete the task of laser
processing.( Motherboard wiring and control panel operations, see the accompanying manual
and control panel wiring board operating instructions)

lll. 1.2 Software supported file formats

Vector format: dxf, ai, plt, dst, dsb...etc.

Bitmap format: bmp,jpg.gif,png,mng,...etc.
lll. 1.3 Environmental requirements

(1) WindowsXP operating system and above, XP recommended .

(2) Above CPU586,above PIII or PV recommended.

(3) Memory, above 1G recommended

84



User’s Manual of Laser Engraving / Cutting software

Il Chapter 2 Software Basic Operation

[11.2.1 The main interface operation
After start the software, you can see the interface shown in the following figure.

Menu bar Graphics System bar || Align bar

Default -

File(F) Edit(E} Draw (D) Config(8)  Hahdie(W)  Wiew(v) Help(H)

DeHdRen dRQARA Dol ~swDa-tof] B %h BIwwn - 1808 FANILE

% %
i G (% A8 o
by [P O P o e R PO P e P P P
== =] Work | Outpur | Do User | Test | Transform
£ = E Lay: ad Speed | Pows output
Pt
S E )
- | .
~ 1% Editbar
O |-
ls=
E Control panel
- gé
2 [
] 7 Lingfcolumn setup
E Hum  space{mm) Dislocation{fm}
X - 1 o 0 @
A E ¥ilt 0 0
= E
o4 R
o [
# E Laser wark
§_: [ st ][ Paussicontinue | stwop |
E La,yer bar [ saverolie ][ uFieCuput ][ Downioad |
’ Path optimize Go scale
EE: A [J output select graphics
] Device
= [ UsB:Auta ]
%54"1 Position: Currert postic v

1312 2 {1 T (i ¥:329. 345mm, ¥ 177 30Tmn

Menu Bar: The main function of this software are available through the implementation of
the Menu Bar. Execute the menu command is the most basic mode of operation. Menu Bar
including: Document. Edit. Draw. Setting. Processing. View and Help.

System Bar: On the System Bar, placed some most commonly command buttons which is
chosen from the menu.

Graphics Bar: Graphics property bar is the basic attributes of graphics operations, including
graphic location, size, scale, number processing.

Edit Bar: The Edit Bar default on the left of the work area. In the Edit Bar placed frequently
used tools to make the operation more flexible and convenient.

Align Bar: Alignment of the selected objects.
Layer Bar: Change the layer of the selected objects.

Control Panel: Using the Control Panel to complete laser processing of multiple tasks, Layer

parameter settings, axis control, processing ...etc.
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lll. 2.2 Language settings and manufactures information

In addition to installation process can set the software language type, you can easily switch in
different language.

Click Menu Bar[ Help )->[ i 5 /Language Jexpand menu, select the required language types.

Help(H)
Ahout ROCAM L_&
| 125 /Language fa &g 3
| E{Fdir
D| [ I 1 :jl::[llﬂl I | I 1 FI::UID| 1 EngllSh
Cither

To obtain manufacturers information,so that we can provide you with better service. Click
Menu Bar [Help] -> [ About RDCAM]

Corp. Mame:
Tel:

Fax:

Addr:

weh:

The bottom of the dialog box shows the current software version number. As different versions of software
may be have some differences on the functions and interfaces, you can easily contact and communicate with
manufacturers through software version number.

[11.2.3 Page Setting

Page setting (3] Click Menu Bar [Config)] -> [Page setting] the following
Page size
Page width: |PEE mnm .
- _ dialog box appears:
arid
GridSpace: (50 mrm . . ] ]
S— [ Page width]: Software page width, usually associated with
adust distance: |1 M .
Adiust ratio: |10 machine X breadth.

Adust angle: |1

[ Page height): Software page height, usually associated

Color config

Background:
WWork areat _ Wlth maChlne Y breadtho

o [ Under normal circumstances, if you have connected to
o ] [ concel | the motherboard, software will automatically format for the
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current work of the machine, as a page size.
If the board is not connected, or need their own custom page size (such as to set the page
size by material), you can use the page setting to reconfigure the page size.

[ Grid]
Setting gird space and whether enable grid.
[ Keyboard]

User can use arrow key to moving or rotating the selected graphics.
[ Color config]

Setting the color of the work area.

lll. 2.4 File Open and Save
The software uses rld file format to save graphic information. layer parameters of various

layers and processing sequence of the graphic elements.
[11.2.4.1 Open File

Click menu [File] -> [Open] ,or click iconi, the following dialog box appears:

EHEE D | FHEE 0:) = c B~

Default. rld

Select file
IWHEE M) |Default. rld FTH @) |
ISR [x.rld =l -

M ELVREA T B

(2) Select file (e.g. Default.rld), click [Open]
[11.2.4.2 Save File

(1) Click menu [File] -> [Save] ,or click iconls the following dialog box appears:
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#IH )X

BEFED: | ZHEE 0 -« E ek E-

[ Defanlt. x1d

Input file name

prat A R - Fault o1 I {275 () |

{RFER (Th: |EL=aser File= (*.r14) ﬂ HDi

(2) Enter the file name in the edit box, then click [Savel.

[ll. 2.5 File Import and Export
Because this software is rld format, so to make or edit the use of other materials will be
done by importing. After using the Export to graphic files for other software.
Supported file format for import : dxf, ai, plt, dst, dsb...etc
Supported file format for export: plt

[11.2.5.1 File Import
Click menu [File] -> [Import], or click icon & The following dialog box appears.

Select file,and click [Open]l.

SA
EREEQ: [ -]« B E-
o] 0000033, p1t o] 9. 1t BiTE. plt
lo] 987 p1t o] BEWH1L plt ] . 14
] 7000, Lt ] B4R p1 e
let) 9578, pLt e 7. P1t
le 0BO721. P14t o] TEFE LR, plt
le] AT. 1t lea] R PLt
B EEERN
] Alphabet. pLt ] . p1t
o] ADF. 1t o] BEERETE. p1t
l] Beach, plt o] P 21t
log] Boxx and Curve. plt | EIFEL. plt
] Box. 31t o] EFE22323. 210
le] Business. plt ] PEEA-2. p1t
le] Cirele. plt o] PEA. P11
lew] CONGEE. pL4 e ELAALES 1t
lo] Curwe. plt o] HLE. P11
ﬂ gemm. plt ﬂ N plt
le job 2. g1t e AR P1E
] shoel2. plt ] 1442 211
o FR2. p1t lea] #EHE. p1t
) 2. p1¢ o B 51t
THEW:  [rirplane plt = Open
FHZER D). [Supported Filesl x| i

@ Select [Preview]), the selected file can be shown.

For most vector file, data automatically imported into the corresponding layer of RDCAM
software according to the layer description.
For some special documents such as DST/DSB, data will be imported into the current layer.
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A

SHEE D 8T

-l emekE-

VERONIEA, DST

FHE W [Ahudiel IST

IR (): [Supported Filesl

Current layer

[11.2.5.2 File export

Click menu [File] -> [Export] or click icon I Export dialog box appears.

Input file name,and click button [Save] .

lll. 2.5.3 File parameters setting

File Parameter §|
Imnpork Setting
PLT Precision: -
DXF Unit: M w

[ import Dxf text info

[5mooth curves
Auto close curves

Close error{mm):

Comnbine lines
Combine errot(mn):

Expork Setting:
Export Precision{ %)
Welocity Unik: | mm/s -

[ Ok, l [ Cancel ]

PLT Precision: According to the accuracy of the original plt
file to select the appropriate import unit.

Smooth curves: When import vector file, automatically

smoothing the original curves. For the original graphic is
smooth or need to repeatedly adjust the beset smoothing
effect, you can uncheck this button. Do not do smoothing
curves may reduce time of import processing.

Auto close curves: According to close tolerance automatic
check and closed curve
Combine lines: According to merger tolerance,

auto-connecting curves.

Color map automatically switch to grayscale: Because under normal circumstances,

graphics are based on grayscale. If the imported bitmap is a color image can be converted to

grayscale.
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Import Dxf text message: When the user need only Dxf the graphic information, not need

the text information within the file, do not check this.
Export precision: The precision of export plt file or output file.

Velocity unit: Software supported two types of speed unit: mm/s. m/min. Selected according
to usage. After it was selected, the speed of parameters on the interface unit will change with
it.

[ll. 2.6 Basic graphics creation

€ Line

Click menu [Draw] -> [ Line), or click Edit Bar ,drag the mouse on the screen you can

draw an arbitrary line. Press the “Ctrl” key while dragging the mouse to draw horizontal or

vertical line.

@ Polyline

Click menu[ Draw]->[Polyline], or click Edit Bar - - Drag the mouse on the screen you
can draw an arbitrary polyline.

€ Rectangle

Click menu [Draw] -> [Rectangle], or click Edit Bar = . Drag the mouse on the
screen you can draw an arbitrary size rectangle.

Press the “Ctrl” key while dragging the mouse to draw square.

@ Ellipse

Click menu [Draw] -> [Ellipse], or click Edit Bar = Drag the mouse on the screen
you can draw an arbitrary size ellipse.

Press the “Ctrl” key while dragging the mouse to draw round.

€ Point

Click menul Draw ]->[ Ellipse], or click Edit Bar * . Click the mouse on the screen, you can
draw an point.

@ Text

Click menul Draw J->[ Text], or click Edit Bar " . And then in a drawing area any position
click, pop-up text input dialog box.
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Text [5_<|
(%) TrueType font: | T Tahoma widths o
O 5 Font: &l Fs.SHX Char space: ICI mm
Text Line space: ICI i
[]Enable variable text
Height: 100 mm I (4 ] [ Cancel ]

Choose font word, input text word, then set high , wide, word spacing, line spacing. Click again [OK] .

The software also supports variable text, the so-called variable text, the text is need according to certain rules
change, every output processing time, text to be automatic change again. For the system variables have character
type date variables and serial number

Text

(]

(%) TrueType Font: | T Tahoma

b | Width: |30 %

Char space:

Line space:

T

Enable variable kext

12Hour[HH:MM][09:03]
12Hour[HH:MM][09:09:21]
24Hour[HH:MM][09:09]
24Hour[HH:MMI[09:029:21]
Armerican Dake[02/07(2012]
Chinese Date[20128 02 Ho7 B]
Chinese Date Time[2012802 B07
Chinese Time[09AT0943 21
European Date Time[07/02/2012a.
European Date[07.02.2012]

week Year[07/02/2012 09:09:21] o
PV S k-

!

oftses [oay [

() 5HX Fonk: 5 Fs.chix
Text
Height: 100 i Apply

] [ OF, ] [ Cancel

]
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Variable is the date when the
current every time processing take
the current system of computer time
output. Software offers a variety of
date format for customers to
choose.

Users can also set the date
migration, have the day by the
month according to the years 3
Kinds.

As in packaging carved on the
expiration period can use the
product.
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Text EJ
@ TrueType font: | T Tahoma hd width: |50 a4, Ext d E]
. o KL ETIL
O 5H font: Fs.sh Char space: |0 mrm
Text Line space: |9 mm :
Q999
Enable variable text Enahle preFix FERC
Prefi:
_ [ |Enable SM array
Suffize:
Start SH; (0000 Murnber Space | | | | | |
Zurrent Sh: 0000 s ¥
SMInc: |1 —
v =
[ oK l [ Cancel ]

Height: 100 mm ’ Apply ] [ K l [ Cancel ]

If ABCOO01DEF processes repeatedly, ABCO002DEF, ABCO03DEF until ABC9999DEF
a group of serial number.

[Prefix] :serial number prefix, example ABC is leading string.
[ Suffix] : the serial number of the suffix, example DEF is the string after.

[Start SN] : from which a specified number start manufacturing, example is to start to

0001 serial number.
[ Current SN ] : the current processing to which, serial Numbers, can also be used to specify

the current to processing which serial number. As in the processing a group of serial number,
leakage processing the one, but through the designated the current serial number to make
processing, not set start, serial Numbers, because in some cases a group of serial number
requires repeated processing, namely to a serial number, need to go back to the start serial
number start manufacturing.

[SN Inc] :the interval number can be prescribed sequence number. Example will in turn

processing from 0001 to 9999 serial number, the increment is 1.
If only need to output even or odd number serial number, can set incremental is 2.

[ Enable reset] : when serial number processing to reset the serial number, [current SN]

will be automatically resetto [start SNJ .

Example requires repeated processing from 0001 to 9999, serial Numbers, so can be
designated 9999 as reset, serial Numbers, when processing the 9999 serial number, text will
automatically change to 0001.

[ Enable prefix ZERO] : if not lead to zero, the system will automatically remove the first

in the serial number of zero digital before the zero. Such as the example, serial Numbers, if
not the leader's zero can ABCO001DEF will become ABC1DEF. But it is worth noting that, if

we want to output serial number is ABC1DEF, ABC2DEF until ABC9999DEF, we can't
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through the will [start SN] set to 1 to achieve, but through the cancel [ Enable prefix

ZERO] to achieve, this is because set in the specified number from the start the serial

number which one, beginning outside, also specifies the number of significant digits, such as
will begin to serial number set to 1, the change of the serial number order is:
1,2,3,4,5,6,7,8,9,0,1,2,3,4,5... Serial number won't change to 10, because the effective a serial
number had 1.

[ Enable SN array ] to the array of way, one-time processing more serial number.

for instance:
0001 0002 0003 after this batch processing serial number, 0015 0014 0013

0006 0005 0004 skip directly to the next group of 0007 0008 0009
0016 0017 0018 0016 0017 0018
& Capture

Click menu [Draw] -> [Capture], or click Edit Bar 4
BB X

WIA-USE fl8Ts &

If the computer has been connected to the image device, the dialog box will appear. After it
was selected, you can collect the pictures from the specified device.

2.7 Object Selection
In the process of drawing and edit graphics,first of all is to select the object.
When the object is being selected,in the center of this object will have a shaped mark* x 7,

and surrounded by eight control points.

Click menu [Draw] -> [ Select]), or click Edit BarRi , switch to status“Select”’ . Under this

status,you can select object. The following are five kinds of method of selecting:

€ Click menu [Edit] -> [Select All] (Shortcuts Ctrl+A) , select all objects.
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¢
<
oLe,

€ Click mouse on the screen to select single object
@ Select object using select box
Press the mouse and drag, as long as the box come into contact with the object will be

selected.
@ Increased select object/minus select object

Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box selects the selected object.

@ Select object according to layer
B &4

BE By, EE  ThE Rl

B ctTE] 100,000 30,000 Yes
I e tTE] 100,000 30,000 Yes
EhiTE] 100,000 30,000 Yes
BhedTEl 100,000 30,000 Yes
I o t0E 100,000 30,000 Yes

3 *
L T

Right-click the selected layer, then the part of all objects in the layer will be selected.
[11.2.8 Object Color

The color of object that is the color of the object contour.You can click the color button on

the Layer Bar to change the color of the object has been selected.The clolor of the pressed

button is the color of current layer.

[ll. 2.9 Object Transformation
Transformation of object mainly include: object location. orientation and size. But does not

change the basic shape of the object and its characteristics.
Transformation of object for users, provides a convenient user interface. User can

=1 00 {4+
mirror and rotation through <810 within the draw toolbar.
You can also use the Object Properties toolbar

¥ 445,91 | mm B (235989 | | 100 | e a .
¥ o|299.208 | mm § 208,549 | mm | (100 | e ﬂ @ G o Process NO: 1
You can also use the right transformation tools to transform and copy the graphics.
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work | output | Doc || User || Test | TransForm

Position:
H: T
W [

[11.2.9.1 Object Image

Wiork || Output || Doc User | Test | Transform

4 ofl&

Object image is flip the selected object in the
horizontal or vertical direction.

Click Edit Bar 4 , flip the selected object

horizontal.
Ratio: -
TE o Click Edit Bar =, flip the selected object
v 100 o vertical.
prror: Or through the mirror to the transformation tools,
horizontal and vertical mirror, and copy.
|:| Disproportionate
d_d_d4
O @ O
A_d_4

[ Apply to copy ]

[ Apply ]
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[ll. 2.9.2 Object Rotate

Click Edit Bar © » will pop up the dialog of rotate angel setting.

Set rotate angle and click the button [OK] .

Eotate E|

Raotate angleldeq) [

[ Ok, ] [ Cancel ]

If you want to drag rotation, set rotate angle 0,and determine.
Dragging the mouse to adjust the rotate angle, in the dragging process, there will be followed
by rotating wire-frame outline.

1

W 445,91 |y WM (235,989 | gy | (100 | e &
0 Process MOt |1
¥ o|299.208 |mm  |208.549 | mm | (100 | e E EE G

Or directly enter the rotation angle in the Object Properties toolbar.

work | output | Dac | User | Test | TramsForm

Rotate:
H: |0
Center:

H: 44591 mim

W |500,791 mm

[JLock rotate center
[Irelative center

Oo-0o-gd
o @ O
Oo-0-0d

[ Apply to copy i

[ Apply ]
Or use the spin rotation transformation tools to transform. In the rotations transformation tool
can be set to the center of rotation and locking center of rotation.
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[ll. 2.9.3 Object Size

%591 | mm H 235,989 | | (100 | = o
1] Process NO: |1
1|:||:| o."'o E E O

¥ |299.208 | mm § |208.549 | mm
You can set size and center position of the selected object.

work | Output | Doc || User || Test | Transfarm

+ o

Size:

H: |235,989 I

Vi 208549 | mm

[ Apply ko copy ]

[ Apply ]

Or use the size transformation toolbar to change the size of object. Can modify the size,
choose whether to lock the aspect ratio, and set the position relative to the object to

transform.
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. 2.9.4 Tilt

work | Output | Doc || User || Test | TransFarm

+ of &| &z
Sk

H: |0 Deg

Vo |0 Deg

[ apply ko copy ]

[ Apply ]

Object can be tilted by the tilting transformation tools. It can be set the tilt anchor and the
tilt angle.

The tilt will cause distortion of the bitmap and the practical application of small,
currently only supports the tilt vector graphics.

[ll. 2.9.5 Object Array Replication

Click Edit Bar L:i , select object wants to copy. Then click od, the following dialog box

appears:
Whum: |1 ®opace: 0,000
Ylum: |1 YSpace: |0.000 EEE
[ Cancel ] | Ok |
¥ Width of a single graphic(mm) I Height of a single graphic(mm)

You can array replication object along different directions. The direction of copy is based on
the original graphics. Such as choose the array direction lower right, then the original graphic
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will appear on the upper left corner.wheras if it is to the upper left array, then the original
graph appears in the lower right.

After setting the array number and array spacing, click button[ Apply],you can see the actual

graphics
array.

There are two forms of array spacing: center spacing and edge spacing.

Choose center spacing, then[ X Distance(mm) ], ['Y Distance(mm) Jrepresenting the distance
of the two graphic center.
If not choose center spacing,then [ X Distance(mm)). [Y Distance(mm)] representing the

distance of the graphic edge.
Center distance X = Edge distance X + width of object
Center distanceY = Edge distance Y + height of object

Switch between the two kinds of calculate method, [X Distance(mm)).['Y Distance(mm)]
will be calculated automatically.

Click [Bestrewing breadth], The software will automatically calculate the array number
according to the workpiece sie. width. height. X distance and Y distance.

Adjust spacing can be directly input values,and click [Apply]

Can also press the dirction keys to adjust objects spacing .

Checkl Center ],then after object array replication,graphics will be centered on the work area.
Scroll the mouse wheel to zoom view of the graphics.

Drag the mouse to pan view of the graphics.

[ll. 2.9.6 Place Object To The Origin

Place the object is to facilitate the view or orientation. The following tools are provided
by software:

= , selected object will be placed in the center of the page, that is the object center
coincides with the center of the page.

AN , Selected object will be placed on the page left, upper right, lower right,

lower left, upper left corner of the object, upper right, lower right, lower left and upper left
corner, top right, bottom right, bottom left corner of coincidence.

lll. 2.10 Object Align

0O 0 nA CT [F
Select objects, click tools on the Align Bar = = 09 oo v 53 H & B H :
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Whick include:

2 & 00 00 | et alignment. Right alignment. Top alignment. Bottom alignment

[ P T i |
o

v == M vertical center alignment. Horizontal center alignment. center alignment
H & Horizontal equidistance. Vertical equidistance

= [ B same width. Same height. Same size.

Benchmark object:

If you press “Shift’key and select object one by one,zhen the benchmark object is the last

object.
If you select object by select box,then zhe benchmark object is the object which curve

number in the final.

[ll. 2.11 Object View

Move: Click menu [Edit]) -> [ Move]), or click to Then hold down the left mouse button

in the drawing area, and drag pan.

+

Zoom Out: Click menu[Edit]->[ZoomOutl, or click ™ . Eachclick it, the drawing area

zoom out once.Move mouse to the drawing area and click,each click,mouse position as
center drawing area zoom out once.

Zoom In: Click menu [Edit] -> [ZoomIn), orclick ~. Eachclickit, the drawing area

zoom in once.Move mouse to the drawing area and click,each click,mouse position as center
drawing area zoom in once .

View Select: Click menu [Edit] -> [ View Select], orclick . Move the mouse to the

drawing area,hold down the left mouse button and drag, a dash border box will show in the

drawing area,release mouse button, then the region in the dash border box will display in the

drawing area with the largest proportion.

L]

View Page Frame: Click menu [Edit]->[View Page Frame]l, or click = . The page frame

will full display.

+\

View Data Frame: Click menu [Edit)] -> [View Data Frame), or click » The selected

objects will full display
lll. 2.22 Group and UnGroup

Edit graphics, and sometimes need to be a part of the operation as a whole (such as
multi-line text layout).
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Method: Select the group of graphics, and then select the menu [Edit] / [Groupl

( [UnGroup] ), or directly select the toolbar | = |

[ll. 2.13 Important Tool

Here are some frequently used tools. Using these important tools, can make the current
document in the graphics more orderly, and make the processing of output more fast.

[ll. 2.13.1 Manual sorting and the set of cutting point and the cutting direction

Software provides users a convenient tool for the manual sorting. Select [Edit] -> [ Set

cutting property] . Cutting property dialog box will pop up. All with manual sorting, and cut

points, cutting the direction of the settings in this dialog box can be completed.

Set cutting property §|
[ ReOrder ” Rewerse H ReQrder ]
O ame ~ MO Mame
1 Elerment 1
2 Elementz
] Element3
4 Elerment4
5 Elements
& Elements
7 Element?
g Elements

a Elementd

10 Element10
11 Elernent11
12 Element12
13 Element13
14 Elemnent 14
15 Element 15
16 Element 16
17 Elemnent17
18 Element 1
19 Element12

20 Elementzn P
z1 Elemnentz1
22 Elementzz e

23 Elemnent23

24 Elemnentz4

25 Elementz25

26 Elerment 26

27 Elementz7

28 Element2&

29 Elermentza

30 Element3n
>

[¥] showPath ﬂ M
X

Show path

First check the “show path”, it will display the current graphics cutting order and the cutting
direction.

Manual sort

select . This button is used to switch the current status of the operation is to edit or view.
Then you can marquee or click the graphics in the graphics display area (or click one pixel or

check many pixels). After selecting the graphic, select , these graphics to be redirected
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to another list, to be processed as the first primitive. Primitives followed by repeated
operations, to complete sequencing of all graphics.

Change the direction of graphic processing

Mouse select the graphic in the graphics display area or in the list. And then click

Reverse

Change the cutting point

Set cutting property &l
[ ReCrder ][ Rewverse ][ ReCrder ]
MO Mame ~ MO Marme
1 Element1
2 Elernent2
3 Element3
4 Element4
5 Elernents
& Elernenteé
7 Element?
g Elements

9 Elernent
10 Element10
11 Element11
12 Elemnent12
13 Elernent13
14 Element14
15 Element15
16 Elemnent16
17 Element17
18 Element1s
19 Element19
20 Elernent20
21 Element21
2z Elementz2 = ]
23 Elemnent23
24 Element24
25 Element2s
26 Element26
27 Elernentz7
28 Element2g
29 Element22
30 Element3n

>

r,’ [+] showPath ﬂ M
Xl

Select the graphics that should be changed the cutting point, it will show all the nodes in the
current graphics. Select the starting point, double-click the mouse, it will change the starting
point of the current graphics. After the completion of all changes, click , the result

of the changes can be saved.
In addition to cutting property features, the software also offers some tools to change the

cutting order, cutting direction and cutting point.
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Select = in the toolbar, or click the menu command [Edit] -> [Show Path] .

Manual sort

Default — RD5.0.0.8

File(E) Edit(E) DrawiD) Config(s)  Handle(w)  view(y) Help(H)
DeE Dl em R E RS (Te o kit = OB

# mm mm % J
i mn § ™m raHE o
| T T T T T | I T T T T
R E Work | output | Doc | User || Test || Transform
3 E Layer | Mode Speed | Power  Output
A B Cut 100000 30000 Yes
A
r |3
=
ol - B m
= J’;O yO
Al g =
* [o- 3 T
= -} & . )
Py i B s < >
; .
x| 4 - -
E IS I3 Device
NE , o
alg] -
- =] 4t i 2 Laser wor 3
ooy " B N Position: Current positic v
| - N .
- - 2 5 Go scale Cut scals
E R - i | )
5 S j
] e . [ output select graphics
7 @ Path optimize
- W ¥
12 (o] revious work time] | OH:OM:0S:0MS
RAmma2x:=0 @816 HEE L[ [ ][ |
--- #Helcoms to use the Laser system of cutting Propose the display srea 10244763 or higher #—- 505, 135nm, 1313, 460nm

Choose the primitive that should be changed the cutting order, then the cutting serial number
of the current primitive will display in the object properties bar.

% (701941 e ¥ [179.659 | mm | (100 | o o
1] Process NO: (17
¥ |243.79 |mm F |63.862 | mm | (100 | e ﬂ EE S

56000 3000 L) G20 0) G40 1)

G50 ) G300 T60.0) Ta0.0) s00 .01

1;

Puon |

I A A

X vl e 002NN A&
P}L'I.UI

L B

(=5
(=

Ab
LB

|
3

Enter the serial number directly in the processing number, then press the keyboard “Enter”
key, or click the plot area, the cutting order will be changed.
Change the processing direction

Click [Edit]->[Set cut direction], to enter the edit mode of the cutting direction. Then you

can double-click on any position on the selected graphic.
Change the cutting point

Click [Edit] -> [Set cut point] , to enter the edit mode of the cutting point. Then select the

curve that should be edited, you can double-click on the node that you want to set the cutting
point to complete the change of the cutting point.
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[ll. 2.13.2 Setting And Editing The Cut In/Cut Out Lines

Drawing or importing curves, the curve is default not have any cut in/cut out lines.

If want to add cut in/cut out lines,select the objects, then click [Edit] -> [Edit cutin

property), or click @ .The following dialog box is appear.

Cut in and out setting E|
Cukin
[#] Enable
Line type: | Line bt

Lengthimm): |2

With angle -

angleldegres): o

Zuk auk
[] Enable
LineTvpe: M e
Lengthimm): |=
(%) Female
(1 Male
[ ik, ] [ Cancel ]

To make cut in/cut out lines, first of all need to enable the cut-in/cut out function.
There are two types of the cut in/cut out lines: straight line and arc

Straight line cut in achieve through three ways:

Cut in with angle: cut in line and starting segment into a certain angle, counterclockwise
angle is positive
Cut in at center, the starting point of the cut in line is at center.
Cut in from center, the direction of the cut in line is from center to starting point, and length
IS as setting.

Cut out line

Cutin line
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The arc length of cut in arc is as setting.

There are two types of cut in/cut out arc, as shown in the following figure

Female Male

She processing of setting cut out lines is same as cut in lines.
[ll. 2.13.3 Path Optimization

Path optimization is primarily to re-order the vector graphics.

Click menu [Handle] -> [ Cut optimize], or click 5% the following dialog box is appears.

Cutting optimize handle §|

[ Jorder of laver

Inside to outside
Single inner to ouker w
Block handle
Height: |57 Dir: |Up to bott +

[ ]5tart point optimize
Auto determine start point and direckion

[ Ok l [ Cancel
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Click menu [Edit] -> [Show Path], or click =, can see the cutting path before and after

processing.

Laser head

Before processing After processing

Graphics cutting path is always starting from the laser head.

[ll. 2.13.4 Curve Smooth
For some less accuracy curves, this function can make curves more smoothness, and
processing smoother.

Click menu [Handle ] -> [ Curve Smooth], or click ©, the following dialog box appears.

Curves smooth [$_<|

Smoothness J— 95% [oirect smooth

| [ Apply HFuIIFrame” Ok ][ Cancel ]
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Drag the smooth slider, and click buttonl Apply1, before smooth and after smooth curves will

all show in the dialog.

The black curves represent the original curves, and the red curves represent after smooth

curves.

Smoothness J 95% [oirect smooth

| | [ Apply ][FuIIFrameH Ok H Cancel ]

You can view the graphics with drag mouse.
You can zoom in/zoom out the graphics with scroll wheel.

Click button [FullFrame]), graphics will shown in the dialog box for largest.

After get satisfied smoothing effect, click buttonl Apply 1, curves will processing smooth

according to smoothness settings.
Select “Direct smooth” , you can use another smoothing method.
The choice of smoothing method should be changed with the needs of the actual graphic.

I1l. 2.13.5 Check Closure

Click menul Handle ]->[ Curve auto close ], or click System Bar [T the following dialog box

appears.

Setting close error §|

Close error (mm):

Fu:-ru:e to close

cancl

Close error: When distance from the starting point to ending point less than close tolerance,
automatic closing of the curve.

Force to close: Mandatory closure of all selected curves.
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[ll. 2.13.6 Remove The Overlap

Click menu [Handle] -> [ Delete overlap] ,or click =, the dialog box appear.

Delete owerlap lines §|

[ |Enable overlap error

Cwerlap errar{mm):

| ik, | [ Cancel ]

Under normal circumstances do not select the “Enable Overlap error”. Removing the
overlapping lines when two lines are compared to a good degree of coincidence. If you need
to delete overlapping lines, you should select “Enable Overlap error”, and set overlap error.
Generally do not overlap error set too large, so as to avoid accidental deletion.

I1l. 2.13.7 Combine Curve

Click menu [Handle] / [ Combine Curvel, or click ¥t the following dialog box appears.

Setting combine error §|

Zombine error{mm):

Ok l [ Cancel ]

The software automatically merge curves in the selected curves, when these curves merge
tolerance is less than the setting of combine error.

[ll. 2.13.8 Bitmap Handle

Click A , and select a bitmap, then click menu [Handle] -> [Bitmap handle] , or click

System Bar *™".
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Bitmap handle @

Width: 500 Pixels
Height: 750 Pixels
H Resolution: 96 Pixelsfinch
V¥ Resolution: 96 Pixelsfinch
Brightness: 0.0%
5
Contrast: 0.0%
g
[Jinwvert color
[[]set output resolution
Resolution{pixelsfinch) |“©
[Iither
Net graphic
Shar
[ Apply to view ] ’ Apply to source ]
[ Get outline |
I I [ Save as ] [FuIIScreen ] [ Ok ] [ Cancel J

In the top right of the dialog box displays the information of the current image.
Be noted that, the horizontal resolution and vertical resolution is changing with drag scaling.

[ Apply to view]: Current settings is only used for preview, without affecting to the original
bitmap, press button[ Cancel ], bitmap will returned to the state of original image. Therefore,
only use for adjust effect. However, this approach requires more time and memory Space.

[ Apply to source): Current sttings is use for orginal bitmap directly, so even finally click
button [ Cancel], image will also unable to return to the original image. Therefore, it mainly
used in multi-step operation, and the current operation of this step is necessary to do, such as
general pictures must be transformed into grayscale. This can save the computing time of the
follow-up operation.

[ Save as]: Retain the results of the previous operation, In addition to usingl Apply to view]
can also be exported. On this basic, to facilitate subsequent processing.

[ Gray scale] Generally, other image processing is based on the grayscale, so before
handling, you can do a grayscale processing, then click button [ Apply to source). For the
grayscale than the color image occupied smaller memory, for large image step by step handle,
to a certain extent to avoid the lack of memory.

For color image, adjust contrast and brightness, have some auxiliary effect to following
dither processing.

Adjust contrast:
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Invert:

Sharp:

Before processing After processing

There are three method for dither processing: Net graphic. Dot graphic. Black and white
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Net graphic
Net graphic need adjust net size, better suited to material which is not high resolution, or the

laser is relatively slow to respond.

To get the appropriate net size, you can adjust resolution and net frequency of the image.
The higher resolution, the more delicate.

The higher net frequency,the smaller net size.The lower net frequency, the bigger net size.
Generally, resolution of image is 500 - 1000, and net frequency is 30-40lines.

-
- &
Dot graphic

Dot graphic performance of good grayscale, better suited to material which is high resolution,

and the laser responds fast.

Black and white

In most cases, the effects of color image into black and white image is poor,, however, for

some clear outline image, is very easy to use.

111



User’s Manual of Laser Engraving / Cutting software

Get outline:

X

Bitmap handle

Width: Pixels
Height: Fixels
H Resolution: Pixelsfinch
W Resolution: Pixelsfinch
Brightness: 0.0%

v
Conkrask: 05%

[CJirvert color

[C]5et output resolution

Resolution{pixelsfinch)
[ oither
’ Apply bo view ] [ Apply to source ]
ul
u = [ Get outline l

| | [save s J[rusween] [ ok ][ concel ]

Click “Get outline” button to extract the contour graph. As following picture
= ;7
n Cﬁ ﬁ ]

i
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[ll. 2.13.9 Processing preview

Click menu [Edit] -> [Preview] , or click System Bar & .

Ml Previer -ﬂ E

RS 365.7mm,108.2mm
Total time 0:01:34.043
Light tine 0:01:17.180
Idle interval 1686.3mm
Fork interval 7718.0mm

Position 0.0mm,0.0mm
Sneel 0.0mm/s

&
<
<
-
(=
(=]

Software supports the preview of the documents to be processed, and you can get some
basic information through the preview. For example, the path of the actual output of the
processing, general processing time, processing the distance. The machining process can be
simulated.

In addition to the current edited file preview, you can also preview the files have been
saved as rd.

Preview rd file:
Double-click in the graphics display area. Choose the graphic you want to preview in the
pop-up dialog box. And then open

Open @

Lock jr: | () My Documents w T G-

1 Adobe Scripks My eBooks 1 5ource Insight

) Baidu My ISO Files i Wisual Studio 2008

JCorel User Files jl"-’ly Music =g

__JFILTERIT4 User Settings :.I"-“Iy Fictures

JksDskore )My ) Files

__JMy Designs I"-’Iy Wi'ebs

£ >

Filez of type: | *.1d w
[ ] 0pen as read-only

Software also supports to set the parameters of preview
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Right-click Anywhere in the graphics display area, the configuration menu will appears.
Select “Config” , pop-up following dialog box

Full windew Configuration &'
Config

Background
Horizontal mirrer Back. calar; . Faont colar; .
Vertical mirror

Drraw color{Power)

o || [ W o
Simulate color(Power)

o [ (T W o
Idle colar .

anchor

) Top left ) Top right:
() Bottom left () Botkam right

You can preview the color of graphics to match the actual output of energy. Users can
easily view whether the layer energy is true.

I11. 2.13.10 Data check

Selected to check after the graphics, click on the menu commands [Handle] / [data

check 1, or click system toolbar B,

Data check r$_<|
Close check end
Check dose Mot find unclose curves
Self-cross check end
[ Auto close Errarimim): I:I Mot find self-cross curves
Craoss check end
heck self-cross Mot find cross curves

Crverlap check end
Mot find overlap lines

Check cross

Check overlap

[ ]Enable errar Error(rm): I:I Check

Data check, integration of the closed inspection, the inspection, the inspection, the
intersection of the fellowship data overlap a check. The user can select a check, inspection to
the problem after data, will be in the dialog box right tip have been found and, at the same
time, the problem in selected state graphics. Check-> ruled out repeatedly error-> inspection
process until all the data are conform to the requirements of the processing.
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[ll. 2.13.11 Generation parallel lines

Selected to create parallel lines after the data, click on the menu commands the [Handle] /

[ Offset poly] , or click system toolbar D

Offzet polwy
Offsetimmi: |0 i i [ ] oelete artwork:
®1mn () ot () Ak Injout

| Ol ] [ Cancel ]

Red line in the figure for the original graphics, green line is inside shrink graphics.

[ll. 2.13.12 LGP design

Click the menu commands the [edit] /[LGP design ] , or click drawing toolbar, already

can start reflex block design tools, the tools are specific to block the sun processing, is an

independent functions, such as the user is not involved in the sun block can be ignored this
section processing content.

Play channel tabula rasa design tools, we first need to design a reflex guide the
outline.Play channel tabula rasa design tools, we first need to design a reflex guide the outlin

Paranster || Output | Systen

LGP Sizeimi:
wickh: (200,000 | Height: (200,000
[ Lack ratio

Apply

[JEnable LGP blark.

wickhy | Height: 200.0
@ Rectangle Olipse.

Apply
Import artworl

[ st [pausercontine][ ston |
[ savetrie ][ outputFie ][ Downoad |
[ soscole ][ cutscale [ Preview ]

Play channel tabula rasa design tools, we first need to design a reflex guide the outline.
In the tool, the default created a 200 X200 rectangular guide tabula rasa outline. The user can

in the tools of "system" page manually create a standard to the shape of the guide tabula rasa
outline.
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Create standard setting the outline can use rectangular or oval.

Create LGP outline
The user can also import a has good graphic

width: (<000 Height: <000 g ) :

O Rectange © tliose dg5|gn, as .the outllpe of the sun. Click on the

"Introduction to guide tabula rasa contour" button,

[ Apply l can choose to have the outline of the document as
the sun. Need to point out that outline file must be

[ Impart artwork l closed graphics, otherwise, the system will
automatically deleted.

Paraneter | Output Systen
LGP Size(mm]:
widkh: (218.1 Height: (200.0

[Lockratio

Apply

[JEnable LGP blank

Height: |200.0

©Fgstands Oielipse

Apply
Import artwork

Usgiuto ]

Postion: Current Fositian ~

[ stan |[pauserconinue | ston |

| saveuris | ourputtFie ][ powrload |

[ coscde [ cusede ][ preview |

LGP Sizelmm):

Width: [215.1 Height: |200.0
Lock ratio

[ Apply

[]Enable LGP blank

S

If the outline of import size requirements, users can also change size outline, and can set
up if stay white edge.
Outline graphics ready, they can start on the tabula rasa increase network.
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LiaP Painkimnm)

LGP type: arid b
width: Height:
UpGrad: UpGrad:

Diowwniarad: DowriGrad:

LeftGrad: Leftarad:

RightGrad: RightGrad:

Spaceimm)

Up: |2.0000 Grad: |0.2000
Diowry: |2.0000 Grad: |0.2000
Left; (2-0000 Grad; 02000
Right: |2.0000 Grad: |0.2000

Base line

s (0,000 ¥ |0.000

Enable row and colown

EnF.ow EnColurmn
Light source
[CLeft [Cright
[(J7ap [ Bottom
[ Apply ]

Network is divided into four ways: straight line, elliptical, rectangle and the grid.

Network is divided into four ways: straight line, elliptical, rectangle and the grid.

Baseline related with light source, the user can adjust the baseline position according to
time light source. In the figure above red graticule marker is the baseline, users can move the
mouse to baseline, press the mouse, and then drag the baseline to want to position.

The entire guide baseline reflex is divided into four regions, level above baseline
definition for uplink and downlink below defined as; Vertical baseline definition for the left
column on the left, the right to define right column.

Set respectively size and spacing network respectively in up, down, left column, the right
column initial value and the gradient of the change, can form users want to conducting tabula
rasa effect.

For grid way, must set exercise can/column that can, can appear the grid.

For the convenience of application, the system to provide the light setup, if the light
source is a standard, can choose the light source, then set the network parameters can be, do
not need to adjust the baseline. At this time, baseline shows hides also.
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Grid way Elliptic way

Left light source Right light source

Top Light source Bottom light source
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LGP cut/Engrave Line, elliptical, rectangular way is the network
100.0 []Default scanning mode of output.

Scanning mode, the minimum energy,
maximum energy general is same, and dedication of
the delay is 0. By adjusting the scanning system

[] 15 blower on precision, to adjust the scanning of the density, the
Scan precision 1016 ¢ more accurately the scanning scan line secret,
scanning the lower accuracy the scan lines sparse.

The grid processing methods is cutting, and
OffDelay: |0.000 ms scanning not precision, and can be adjusted
according to the actual effect, the maximum and
minimum energy energy light switch delay,
generally speaking, the least energy slightly lower

Speed(mm)'s):
MinPovwer(%s): |30.0 [ ] Default

MaxPower(%e): |30.0

OnDelay: (0.000 me

Ckline cuk

[ ]Enable outline cutting

Speedimm/s): than the maximum energy.
MinPower(%s): If need to cut the reflex the outline, make can
MaxPower(%): contour cutting. About cutting parameters and
common cutting Settings identical, in hereby here.
If need to press array in the way processing
OnDelay: ms more panels, can be set to array parameters; Array
OFfDelay: ms direction along the machine is always the origin in

the opposite direction.

Orray paramekters

% Mum: |1 % Space: |0.000

¥ Murm: |1 ¥ Space: (0.000
[ USE: Auto |
Position: Current Position W
[ Stark ”Pause,l'Cu:-nI:inue ][ Stop ]

[ SavellFile ” CukputUFile ][ Cownload ]

[ GaoScale ] [ Cutscale ][ Presig ]
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lIl. Chpater 3 System Settings

Before output graphics, required to determine whether the system settings are correct.Click

menu [Config] -> [ System Setting]
Config(sh | Handlelw)  Wiew (W

Systern Setting

File Para Setting

Page Setting
Passwrord Setting

Graph Hatch
Shiowy Array
Show grid

lll. 3.1General settings

Setting

General setkings System Info
Aecis Mirror Laser head
[ axis ¥ Mirrar ©@ O O
C O O
Bais Y Mirraor O OO0 [ | absalute coordinate
small circle speed lirmik Scanning(Reverse inkerval)
Diameter(mm) Speedimm)'s) Speedimm)'s) Reverse intery, ..
£ > < »
add.. | | Delete add.. | | oel |

Axis Mirror

Generally, Axis direction of mirror is based on the actual location of the limit or home of
machine.

The default coordinate system if Descartes coordinate system, and zero in the bottom
left.

If the zero point of the machine is top left, then X-Axis do not need to mirror, but Y-Axis
need to mirror.

If the zero point of the machine is top right, then both X-Axis and Y-Axis are all need to
mirror.
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In addition, this function can also use to other application for mirror.

Default — RDH.0.0.9 Q@El

File(E) Edit(E) Draw (D) ConfigiS) Handle(W)  View(y) Help(H)
e AR e CTHQOQRA | e Yo ki OB %

X mm e mm % a
v mm J mm %, ﬂ E (6.4
Ox | 01 | 0] | 4001 | G001 | EIE| 1000 1] 12001
o b e A e e e b e e T e e

K work | Output | Doc | User | Test | Transform
£ - layer | Mode Speed  Power | Output
e >
A ‘_)
o
i
Sl

=
Alg-
.| -
! ] < >
SE

i Dievice:
IR TR
= 1F
=
ol Laser work
- Pasition: Current positic
|5
ol [ Gosale | [ cutseale |

- SaveTolFile UFileCutput:

[Joutput select graphics
Path optimize

i frevinus work b |H:OM:05:05

-

=-

= D

EAnR®E = i=08F - RN EEEEEE [ ]

—- #ffelceme to use the Laser system of cutting Fropese the display ares 10Z4#TES or higher #— £:773. 95Tnm, ¥: 284, STanm

Laser head
Position of Laser head means the location laser head relative to the graphic.

Top Left . Top Middle Top Right

Middle Left Center Middle Right
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V5 WoR W
o0 00 00
Bottom Left | Bottom Middle Bottom Right

when you intuitive view, just look at the zone where the green point appears.

[=] ] n
" ¥ »

Absolute Coordinate

You can directly check this option when you want the graphics location in the graphics
display area correspond to the actual work location of processing. Then the graph position
will no longer relate with the actual output position of the laser head and orientation point,
but always regard mechanical origin as the anchor point.

Small Circle Speed Limit

On processing work, the software automatically determine whether the current round need to

limit speed ,then according to the diameter size of the circle to determine the speed. If
parameter configuration appropriate ,will greatly enhance the quality of small round. Click

button [Add), [Delete]l , [Modify] to configuration.

Small circle is less than speed of the rules limiting the list of small round circle of
minimum radius, minimum radius circle at the speed of the output of the corresponding.

If the speed greater than maximum speed limit list the speed round, the speed only
associated with the speed of the layer.

If the speed is in the list, set the output speed by list.

If the request received by limiting layer parameters faster than the speed set in the layer,
press the speed of the output layer.
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Scan backlash
Laser scanning graphic way, because the relationship between the machine belt tension
may cause the edge of the scanned graphics uneven. Therefore, increasing backlash to fix. It

has the specific backlash for the certain speed. General, the greater the speed, the greater the
backlash.

@O Add backlash
Click the Add button, the screen will pop up as shown in Figure

X]

Speedimm)'s)

Reverse inkervalimm) 0.4

| (o3 | [ Cancel ]

In the interface can modify the current speed of the corresponding backlash.

(3 Remove backlash
Right-click scanning (reverse gap) block in the backlash to delete the item, then click the

[ Delete] button.

lll. 3.2 System info

Setting

eneral settings | System Info |

Wendor passwaord: | [ Input

Mainbaoard version:
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Information on the operation of the motherboard manufacturers need to enter password to
view parameters.

setting

General settings | System Info

Total on time{hour ;min:s):

Total processing timedhour imin:s):
Presvious processing timelhour : min:s:ms):
Total laser on timedhour imin:s):

Total processing kimes:

 Total travalim):

% Taokal kravel(m):

Mainboard version:

Total on time: The total time of motherboard working

Total processing time: The total time of processing ,including the time of jump moving.
Previous processing time: The time of the last processing

Total laser on time: The time of the laser processing

Total processing times: The number of completed processing, not include the processing
forcing to end.

X total travel: The total travel of motor X.

Y total travel: The total travel of motor Y.

Motherboard version: The version of the current controller,

The function of upgrades:

If the board has additional features, the manufacturers will provide the update file  (*.
bin format), the user can load the upgrade file to upgrade the motherboard. After the upgrade,
you need to click on the control panel "Reset" button reset the motherboard before normal
use.

lll. 3.3 User parameters
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Wark || Oukput | Doc User | Test Transform
=] cut parameters e
Idle speed(rm;s) 200,000
Idle Accimm,s2) 2000,000
Start speedimms) 15.000
Min Accirmm,s2) 500,000
Max Accimmfs2) 2000,000
Cutting mode Mormmal Cutting
Acc Mode S mode

SwWeEBp parameters

¥ Start Speed(rmyfs) 20,000
y Start Speed(mmfs) 15,000

¥ Accirmmfs2) 2000,000
y Accimimfsz) 2000000
Lire Shift Speed (rm, 150,000

Scan Mode Cornrnon Mode
Facula Size(50~99%:1 95,000

Horne para

Horme speed(mmfs) 20,000

Ato home ¥ Yes

Auto home v Yes

Auto home z [Wa]

[ o e I | hl—

Reading the board parameters must before operating the user parameters.

lll. 3.3.1 Cut parameters

= cut parameters

Idle speed(mmjs)
Idle Accimmfsz2)
Start speedimmfs)
Min &ccimmfs2)

200,000
2000,000
15.000
200,000

Max Acc(mm,s2)
Cutting mode
Lo Mode

2000,000
Mormmal Cutting
S mode

Idle speed: this parameter decides the max. speed of all lines not emitting beams during the
operation of the machine. This parameter should not be lower than the lower of the jump-off
speed of the X-axis and that of the Y-axis and not exceed the higher of the max. speed of the
X-axis and that of the Y-axis, if the setting is illegal, the controller will automatically set this
parameter within the range above; a comparatively high idling speed can shorten the
operation time of the entire figure while excessively high idling speed may cause dithering of
the tracks, therefore, you should take all relevant factors into consideration when setting.
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Idle Acc: Corresponds to the acceleration of the speed of air travel time, air and
air-way-way speed of acceleration to match, if you set too slow the actual speed may not
reach the air-way set value, if set too fast, they may not withstand the mechanical structure,
resulting jitter . Slightly higher than the general acceleration of air-way cut acceleration.
Cutting Acc: Corresponding to the acceleration of the speed of cutting (cutting speed is the
speed of the layer parameters of the layers).

Turning speed: Turning the corresponding deceleration in the cutting process, the minimum
speed of the drop, when processing a lot of teeth when the graphics may be appropriate to
reduce the turning speed.

Turning Acc: Should match with the turning velocity.

Cutting mode: Split precision cutting, fast cutting, ultra-fast cutting, the user can choose
according to the actual applications. Such as the emphasis on accuracy, select the precision
cutting, such as emphasizing speed, select the fast cutting.

Acce. mode: this parameter decides the acceleration and deceleration mode (S mode or T
mode) of the motor during operation, the motor accelerates and decelerates slowly and
smoothly in the S mode and fast and relatively unsmooth in the T mode; the default mode is
the S mode.

1. 3.3.2 Sweep parameters

= Sweep parameters
¥ Start Speed(mmfs) 20,000
y Start Speed(rmf=) 15,000

¥ Accimmfs2) 2000.000

v Accirmmmfs2) 2000,000

Line Shift Speed (rrn, 150,000

Scan Mode Carmmon Mode

Facula Size(S0-99%7 93,000

x Start Speed, y Start Speed: Off scanning speed in the use of stepper motor drag, do not
began to accelerate from 0, but can start work directly from a speed to shorten the overall
processing time, but the speed is not too high, and because the X, Y axial load is different
from the rate, general the initial speed of X-axis slightly higher than the initial speed of
Y-axis

x Acc, y Acc: With the scanning speed (the speed of layers in the layer parameters) to
match, if set too small, the scan speed to a longer distance, the scanning efficiency. The
machine can be set according to the actual structure, load conditions vary. Since X, Y axis
load, generally much higher than the X-axis Y-axis accelerometer.

Line shift speed of scanning: this parameter is specially used to control the max. speed of
the scanning to shift vertically from one line to the next line below it. If during the scanning,
the line space is too large or the block space is too large when scanning block figures while
precise positioning for each line or block is required, you can set the line shirt speed of
scanning to a comparatively low value. This parameter cannot be less than the jump-off
speed of the corresponding axis during the line shift and cannot be higher than the max.
speed of the corresponding axis during the line shift, if the setting is illegal, the controller
will automatically set this parameter within the range above.

Scan mode: There are two modes for your selection: the general mode and the special mode,
in the general mode, there’s no any treatment during the scan, in the special mode, light spots
will be treated. If the special mode is activated, the power of the laser should be increased
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and correspondingly, the light spot percentage will be lower and the laser power attenuation
will be higher, to achieve the same depth of scanning, the laser power should be higher. The
purpose to select the special mode is to make the laser to emit beams at high power and in
short period, during deep scanning, the effect of flat
bottom can be achieved, however, if the light spots are improperly adjusted, this effect may
not be achieved and the working mode of high power and short period may influence the
service life of the laser. The default mode is the general mode.
Facula Size: When scanning the general pattern of selection, the argument is invalid, when
you select a special mode, the onset of the parameters. Control the parameters of control in
50% to 99%, respectively.

lll. 3.3.3 Home parameters

=] Home para
Horne speedimmm,/s) 80,000
Auto home ¥ Yes
Auto horme Ri=3
Auto home 2 MO
Auto home U [Wa]

Home speed: This parameter determines the machine is turned back to the origin when
the speed of a larger format if the machine can be set to reset the speed is too large, but not
too much.

X,Y, Z, U Auto home: The axis can be set whether should reset at boot time.

lll. 3.3.4 Go Scale parameters
= Go Scale para
G0 scale mode Close laser
Go scale blank({rm) 0,000

Go scale mode: Points of light to go off the border, the opening cut borders, corners three
modes.

Go scale blank: Walking frame can be based on the actual image size up and down again
about the direction of some of the white left side of the border in order to ensure complete
contains the actual graphics.

This setting is on the control panel to go with the border-related functions, while walking
on the border with the independent software.

[ll. 3.3.5 Other parameters

(=] Other parameters

Array processing Bi-clir &rray
Return position Ahsolute Origit
Delay before feed(s)  0.000

Diealy after feed(ms) 0,000

Focws depthirmr) 0.000

Backlash ®{rmrm) 0,000

Backlash Y{rmm) 0.000
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Array mode: you can choose the swing mode and the one-way mode. The Swing mode:
cutting the array back and forth in order; the One-way mode: always cutting the array from
one direction to another. If One-way mode is selected, all array units have the same
movement modes and the same liquidity of movement, however, this mode will take more
time than the swing mode. The default mode is the Swing mode.

Return position: You can select the locating point and the machine origin. This parameter
decides the position, the locating point or the machine origin, where the laser head stops
upon completion of each operation.

Delay before feed: Using the feeding device, the delay before a single feed, users can arrange
the time and the like, such as picking process.

Delay after feed: Refers to the material sent to the feed device in place, the need for stability
after a period of time for processing.

Focus depth: Auto focus operation to find the corresponding panel.

Backlash X, Y: Used to compensate the backlash caused by the machine drive problems.
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lll. 3.4 Document Management

Work | Qutput | Doc User | Test || Transform

Murmber File Mame Time(H:M: 5 M3
[ Read ] [ Process ] [ Download ]
[ Delete ] [ Delete ol ] [ Zal kirne ]

Read
Click button Read, the software will communications with the controller, read the list of

files on the controller.

After read controller successful ,file information will be displayed in the document list.
Download

Click button Download, will pop up the file dialog , select *.rd downloaded file, then the file

will be downloaded to the controller.

If the download is successful, the document list will update.

Process
Select the file to be processed from the document list ,and click button Process

The controller will start the specified document.

Delete

Select the file you want to delete from the document list, and click button Delete

The controller will delete the specified document.
If the deletion is successful ,the document list will be updated.
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Delete All
Automatically remove all file in the controller, and update the document list.

Cal time

Motherboard supports processing files towards hours worked. Select the file to calculate
the work hours worked and click the button. Calculation to be completed, the control panel
will be prompted to complete the calculation. And then point to read button shown in the list,
calculated from the working hours.

In addition, when the document processing operation performed, the hours information
will also be covered by the actual processing work.
Uploading

On the main board of the selected from read offline files, and saved to the computer.

lll. Chapter 4 Processing Output

/ Processing control
Laser work,
[ Skart ” Pause/Continue “ Skop ]
[ SaveTolFile ” UFileutpuk H Dotwnload ]
[[]Path optimize
[ ] output: select graphics
Drevice
Search

’ JSE: Auka

Position: Current positic

I1l. 4.1 Search Device

Link device in two different ways: USB and network.But through some equipment port
button on the popup dialog box, set connection mode and choose connection port.

(%) USE: Auka | [ search

wveh:

Default IP;

If the computer only connected one device, you can set to Auto. The software will

automatically search the device.

If the computer connected many devices, then first of all you need to click [Find com] .
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After search, the connected devices will all add to the drop-down list.

What you need to do is select the specified device.

Network: if the computer is connected only a laser equipment, which can be directly in the
default IP address to enter in connected device IP.

When the computer connection has many sets of laser equipment, and USB operation is
similar.

Search at present already connected device, and choose from the drop-down list
corresponding IP address machine.

lll. 4.2 Layer processing

First, in the menu [Handle] -> [ Path optimize] check “according to layer order”, then

click “OK” to exit.

Layer reorder: Click button Up, Down can change the order of layers, or direct the mouse
to drag the layer to the specified location.

Here, you must check the “Path optimize” option.

I1l. 4.3 Position

Setting the laser head back location after processing completed.(Current position. Original

anchor. Machine Zero.

Current Position : Laser head back to the position before processing.
Original anchor : Laser head back to the last anchor ,the anchor may set at panel.
Machine zero:  Laser head back to the zero of the machine.

Il. 4.4 Go Scale. Cut Scale

For Example Go Scale, As the following figure shown, the actual graphic is round, and the
red rectangle outside the circle is the smallest rectangle, click button Go Scale, laser head
will run once along the rectangular path.

(O

For Example Cut Scale, As the following figure shown, the actual graphic is round, and the
red rectangle outside the circle is the smallest rectangle, click button Cut Scale, laser head
will be cut along the rectangle.

lll. 4.5 Start. Pause. Stop. SaveToUFile. UFileOutput. Download

Start: Output the current graphic to the machine for processing.
Pause\Continue: Click Pause, will stop the processing work, click the button again to
Continue

Stop: Stop the current processing work
131



User’s Manual of Laser Engraving / Cutting software

SaveToUFile:
Save current file as RD format, using for offline processing (Can be copied to other memory
board for full offline operation) .

UFileOutput:
Output the offline file (RD format)
After save offline file, click UfileOutput to select rd file to processing.

Download:
Download the file to the memory of the controller , then user can start the file through the
machine panel.

[ll. 4.6 Output select graphics

After check Output select graphics, then only output the selected part, rather than not

output the part not selected.

lll. 4.7 Path optimize

After check Path Optimize, then automatically perform the path optimize before the

output.
If has done the Path optimize or not need optimize, then not check Path Optimize can
reduce waiting time.

. 4.8 Test

Wark || Oubput || Doc User | Tesk | Transfarm

Current Position n=t
Y=¢
=¥
Axis Move
CfFsekimmm): 10
Speed(mms): |30
| A= |Home|| =4+ [|Home Pawer(%ad: [0

I Move From origin
[]1f Light:

Axis control, can only control one axis each time. You can set the information for axis move,

including move length. speed. laser on-off and laser power.

If you check “Move from origin”, then the offset you set means the offset to machine zero.

If you not check move from origin, then the offset means the offset to the current position.
The X-axis, for example, assuming the current position is 100mm, such as the step distance is
set to 10mm, then the exercise once, the new location will be 110mm, such as the check
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moves from the origin, movement time, the new location will be 10mm, and repeated
Movement, location will no longer change.

Note: According to the provisions of the controller, the absolute position is no negative in the
whole breadth. If you check the Move From Origin, and set the offset value negative, then
the machine will hit limiter.

[ll. 4.9 Output Setting

Work, | QuEput | Do Uset || Test || Transform

[ ]Enable rotate engrave

Circle pulse:

Diameter{mm):

Speedimm)s):

[ ]Enable Feeding

Feeding Count:

Distancelmmm):
[ |Backlash reapy optimize

[ |Enable offset of Laserz

W '

lll. 4.9.1 Rotating sculpture

[ Enable rotate engravel: After enable engraving, the actual precision of Y-axis will be
based on diameter and step per rotate to auto match the setting of pulse precision of Y-axis. In
addition, the work area in the main interface will also change.

[ Diameter): The diameter size of the parts.

[ Step per rotate): The number of pulse corresponds to the workpiece rotate one week.

[ speed ] : testthe speed of work.

The function is to facilitate the users to replace parts, and different size of the workpiece
when the workpiece is not very different before use. When the relatively large difference in
size of the workpiece, it is recommended to use directly modify the motor step approach to
implementation.

Rotary engraving is only when using the rotation axis to replace the Y-axis use.
lll. 4.9.2 Feed Setting

To use the feed, must first enable the feed.

After set feeding parameters, the shaft will be feeding a feeding length, and repeat the
process , until the times of processing reach to number of feeding.

If the machine is not equipped with feeding devices, in general, enable the feed ban.
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lll. 4.9.3 Optimization of Backlash Compensation

When the machine there is space (such as dislocation of the seal cutting graphics), can be
checked.

lll. 4.9.4 Optical 2 migration
In need laser collaborative work, complete the same graphics processing occasions,

usually, to use the optical 1 to define the graphics location, then if the optical 2 can accurately
with the optical 1, will need to specify the optical 2 relative to the optical 1 offset.

This generally used in two power different laser tubes of machine, because two of laser
tube power different, cause different functions.

If some machines equipped with two different power of laser tube, a responsible for
cutting, a responsible for sculpture.

[ll. 4.10 Layer Settings

Wark, Oukpuk || Doc =ser Tesk TransForm
Layer Maode Speed Pawer Cakpuk

B .t 100000 20.000 Yes
B Ut S00000 30.000 0 Yes
i

s

l Up l [ Davan ]

Line/calumn setup

Fum space(mm) Dislocationmm]) :l‘_’[
w1 1] 1]

lll. 4.10.1 Ranks se
For convenient to set in machining graphics processing on the array.
X numbers and Y numbers, which was the array of columns and rows.
X intervals and Y interval, respectively is array of the column spacing and line spacing.
Layer: Software use layer to distinguish processing graphics parameters of different

layers.
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Ind

If hope X interval and Y interval which between is representative of array center of the
Epd

Adjust the X, Y interval between enable graphic layout more closely, can click drawing area,
make graphics in the selected state, and then through the keyboard of the up and down or so
key to adjust, and rolling the mouse can be displayed scaling, make the spacing of the
adjustment process more precise.

.The X interval is said and Y representing between interval graphics margins.

graphics spacing can switch to

[ Bestrewing breadth] :According to the size of the wide and the current user Settings

ranks spacing, to determine how much can output the most listed (i.e. X number) how many
lines (i.e., Y number). Click on the button

Beztrewing breadth EI

¥ breadthlmm):

Y braddeh(mm): |00

[ ok, l [ Cancel ]

[ Brestrewing breadth] , pop-up interface as shown in figure:

According to determine the button, the software can automatically calculate the entire
width of the ranks of the arrangement number.

[ dislocation ] : for some graphics, in arrangement, the dislocation arrangement, can

make the arrangement more compact.

SO0} .

[ The application to copy 1 in good array, chosen to copy graphics, some application to
copy, already can duplicate array graphics.
In the layer list to edit the double click inside layer, namely will pop up layer parameter
dialog box.
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The left article color, representatives of the current graphics layer, choose different color,
can be in already switch between different layer, one-time modified multiple layers of
parameters.

The layer parameters is divided into two parts: public layer parameters and turn a layer
parameters.Public layer parameters is to point to no matter how the layer processing type, all
effective layer parameters;

Proprietary layer parameters is to point to the layer of processing type change of the
corresponding parameters will also be changing.

Layer Parameter E‘
FAN l Load parameters from library l
[
- Layer:
Is Cukpuk: =
Speedimms):  |400 [Joefault
If Blowing: | Yes -

Processing Mode: | Cut -

Min Power(3:) Max Power(%:)

Laserl: |30 30 [oefault

Laserz:

Seal: |0.000 i

Open Delay: |0 s
Close Delay: |0 s

Laser through mode

=~ [ k. ] [ Cancel ]

lll. 4.10.2 Laser Scan Parameters Setting

Laser:Software to distinguish between different layers of the graphics processing
technology parameters. For scanning processing methods, more are in the same layer bitmaps,
and whole as a picture output, if hope each bitmap single output, it can be a graph
respectively placed in different layer can.

Is Output:Have two options: yes and no. Choice is, the corresponding layer will output
processing; Choose no, won't output processing.

Speed:The corresponding processing method of processing speed.

For cutting processing is concerned, the slower, processing the better, the more smooth
track; The faster the processing results, the worse the trajectory smooth;
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To scan for processing, the slower, under the same energy scanning depth, deep and
scanning trace the thick, scanning the resolution also reduced.

The faster the same energy the shallow depth of the scanning, details distortion increase.
To fix for processing, the main change is empty the speed of the move.
If, check the "default™, the actual speed by panel set up to speed.

If Blowing:f the machine external fan, and fan has enabled, then if choose "is", then this
layer data processing, will open the fan, otherwise, will not open the fan. If you do not make
can fan, no matter choose "yes" or "no", are meaningless.

Processing methods: says the method of processing corresponding layer;

If the currently selected is vector layer (i.e. color layer), it includes three choices: laser
scanning, laser cutting, laser rbis;

If the currently selected is a tutu layer (namely BMP layer), the only include a choice:
laser scanning.

Laser 1, laser 2: corresponding to the mainboard laser signals 1 and 2 of the way way
laser output. If it is only head machine, the second road laser meaningless.

The minimum power, the maximum power: the power of the values of the range of 0 to
100, said that in the process of the strength of the laser processing; Big value, the laser is
strong, is small, the laser weak. Minimum power loss to the most power is less than or equal
to.

For different processing type has a different meaning.

For cutting processing, the actual power is cutting speed and phase follow, speed, low
energy is also low, high speed is high also, so that we can guarantee the whole process of
cutting energy evenly.So the minimum power the speed of the corresponding minimum
energy, the minimum speed general is O, but if set the speed is the minimum speed for takeoff
take-off speed; The maximum power correspond to the layer speed.

Set minimum power, and the most high power flow:

1> The minimum power and the maximum power set to the same value, synchronous
adjustment. Until all the cutting curve are already appear.

2> The maximum power unchanged, and gradually reduce the minimum power until the
energy of the heavy cutting curve at the lowest level, and all of the cohesion parts can be
processed to come out.

3>If not yet to best effect, can be the most appropriate fine-tuning high power, and
repeat step 2.

If is cut through, the minimum power loss and the maximum power no significant
difference, can be set to give the same.
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To scan processing, ordinary scanning, the minimum power and the maximum power
must be consistent. Slope sculpture, minimum power loss is the power of the corresponding
factors, the most power is the power of the bottom of the corresponding.

top

botto

Minimum power loss is the top for the small slant wide, detail place distinguish clearly.
Minimum power loss is too large slope not obvious.
To fix processing, the minimum power and the maximum power can be set to agree.
If checked "default", the actual power panel set by the power to determine.
Click the button "advanced", but also can be set to other layer parameters.

Other layer parameters g]

[ ]Enable pen up and down

mrmn

mrmn

Speed:{mm//s):

Pioink
Dot inkeryal(s) a

Extend I0 oukpuk

[

| Ok | [ Cancel ]

[ Pen up and down] If machines have installed the lift platform, and need to be in a
different platform height on the processing, can make can write up function.

Here the corresponding is platform write position in which high on the processing,
carried the corresponding is empty pen position before go, platform should be moved to
which level in the optical translation will not again to interfere with the process workpiece. If
confirmed the optical not and the translation of the process workpiece to interfere, don't need
to set up the pen position.

Use way Is:
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1> Can write pen to carry.

2>Make can write position, manual control panel key mobile platform, to stay
processing graphics graphics processing plane, adjust the focal length. Then click button
"read"”, and then write all set up position.

3>That can carry a position, manual control panel key mobile platform, move to the
optical will not interfere with the work of the height, and through the panel key move the
optical, confirmed that won't interfere, some button "read", and then set up a position.

[ point]

Here the rbis, and is suitable for drawing tool create a point figure yuan, or from DXF
file into the spot diagram yuan. And the current layer processing methods has nothing to do,
namely whether the current layer is cutting or a scan, graphics in the spot diagram yuan has
always been to the rbi way output.

The rbi movement speed for layer speed, beating the energy for the maximum energy
layer laser.

[ The laser Enable]

When the machine is equipped with two road laser, usually, are two road and output.

But the user may through the set that laser, that its not output all the way.
[ The joint 10 output ]

All the way and the layer associated 10 output, obligate function.

[ll. 4.10.3 Laser scanning parameters Settings

Layer Parameter g] Layer Parameter
L Load parameters From library ] — l Load parameters from library l
| ] I
Is Oukput:  Wes - Is Qutput: | Yes hd
Speed{mm/s): 100 [Joefaul: Speed(mmys;: 100 [] Defadlk
If Blowing: | Yes - If Blowing: | Yes -
Processing Mode: | Scan - Processing Mads: h
Min Power{%) Maz Power(=) 1¥in Power{s) Max Power{%)
Laserl: |30 30 [oefaul: Laserl: |30 30 [ pefaul:
Laser2: Laserz:
[IMegative Engrave [ Optimized Scan
[l1ndependent autput [l output direct [Jindependent output
[ Iramp Effect
Ramp Length: mm Ramp Length: mm
Cwerstriking: |Un-process | Crerstriking: | |Un-process |-
Scan Mode: | n_swing hd Scan Mode: |X_swing -
Interval{mm): (0.1 Inkerval{mm): |J.1
A [ ok | [ cancal | - [ ok | [ cancel |
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On the left of the dialog box for vector scanning parameters Settings, on the right side of the
dialog box for bitmap scanning parameters Settings.

The vector data do not support the scanning the color carving, optimization scanning, direct
output.

The color carving: normally scanning, bitmap in the black spots a laser, the laser in white.
Choose the color carving, the bitmap in the white of the laser, black spots in a laser.
Optimal scanning: choose optimization will automatically adjust the users scan the scanning

interval to set up the best value, the scan best effect.
Otherwise, according to user Settings of the scanning interval scan pattern. Generally
choose "optimal scanning™
Direct output: grayscale bitmap, according to the actual graphics gray.in output, already color
deep place laser energy big, color shallow place laser
Energy is small.
Figure yuan respectively output: for vector graphics for, figure yuan respectively according
to vector diagram output is the position of the yuan relationship, which in turn will get
together the vector map carving output of yuan respectively.
If not checked figure yuan respectively output, it will be the whole vector graphics as a

whole to sculpture.

For a bitmap for, if not checked figure yuan respectively output, the system will
automatically will work with a layer of the bitmap in as a whole output.
If checked the figure yuan respectively output, the system will be in a single output bitmap.

Slope effect: the scan the edges of the figure appear slope, submit stereo effect.
Be bold font: including don't handle, scanning the font, scanning the bottom. Generally
choose not processing.
Scanning is part of the font scanning is the font, also is the Yin carving.
Note that the slope effect choice, please will be bold font choose not to deal with, or slope
affected the effects.
Font Yin carved: not to add text outside the box, scanning are text itself, as below:
XK 115

Font Yang carved: text and the outer frame, scanning is the bottom of the graphics, as below:

Xk 30 fE A

Scanning mode: including level one, level two-way, vertical one-way, vertical two-way.

Level one way: the optical scan pattern back and forth in a horizontal direction, but only
to a direction when laser scanning comes out,Such as: when the optical scan from right to left
a laser, and from left to right the laser scan.
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Level two-way: the optical horizontal direction in the back and forth laser scanning
graphics.

The vertical one way: the optical scan pattern in vertical direction back and forth, but
only to a direction will be laser scanning, Such as: when the optical scan from up to down a
laser, and from the bottom to scan a laser.

The vertical two-way: in vertical direction the optical back and forth laser scanning
graphics.

Note: general use level two-way scanning mode.

Scanning interval: namely the optical scan every much long distance under a line. The
smaller the interval, scanning the deeper to graphics; Conversely, the more shallow.

Suggestions: (1) for vector layer (i.e. color layer), scanning interval in 0.1 mm general
set below.
(2) for a tutu layer (namely BMP layer), scanning interval in 0.1 mm general set above,

Then through the change and the most high power to make the minimum power after
scanning the graphics depth to achieve the ideal effect.

[ll. 4.10.4 Laser Cut Parameters Setting

lLayer Parameter

FaN Load parameters From library |
I
Laver: |
Is Cukput: 7
Speedimmys): | 100 [ ]Default Seal cutting has not closed the graphics
IF Blowing:  Yes - appear the case is closed, you can
Processing Mode: | cut - compensate with the seal to close, but if
the seal is misplaced, you can not
Min Power(%s) Max Power(%) compensate, you can use 4.9.5
Laserl: |30 30 [ ]oefault optimization backlash compensation to
Lasers: compensate, or to use the user parameter
in the Backlash compensation .
Seal: D-DD%'
Open Delay: |0 /I:ns/' Open delay
|
Close Delay: |0 s ~
"| Close delay
Laser through mode
If checked, the light switch delay is playing
~a| in time said.
~ Ok ] [ Cancel ] . . ) o
Otherwise, the light switch delay said is
laser movement delay.

Using the slit width compensation can compensate for the offset between the graphics and
the actual output graphics that caused by laser cutting.
It only has effective for the closed graph.
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Direction: Compensation direction is set according to actual needs, such as cutting a
circle, if you want to retain the cutting down of the circle, you should set out the direction of

compensation; If you want to keep the hole should be set to compensate for the inward
direction.
Sew width: it is the width of the laser.

Other cutting param E|

[ |Enable sew compensation

Direction:

Sew width M

| ok, | [ Cancel

[ll. 4.10.4 Laser Dot Parameters Setting

Layer Parameter §|
Is Oukpuk; | Yes W
Speedimmys); | 100 [ ]Default
If Blowing: | Yes -

Processing Mode: | Dok -

Min Power(%) Max Power(%:)

Laseri: |30 30 [ | Default

Laserz: |30 30

The time for emitting laser on
one dot during the process. The

/' higher the value is, the darker
I

Dok bime: 3.1 s
_—"| The interval between the dots
Dot interval; (5] Trin
|
Ciat length: |© L p——P

Dot length, for cutting dash line

[ center dut\ |

Only dot at center

ok, ] [ Cancel ]
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IV Introduction of AutoCAD_Laser

IV .2.1 Features of AutoCAD_Laser

Mainly used in movement control, it is an important part of laser movement

control and is. It realizes effective control of laser numerical control machine tool

by computer and accomplishes processing tasks according to user’s different

requests.

AutoCAD _Laser is a plug-in module stalled in AutoCAD, utilizing indirectly the
powerful functions of plotting and edit of AutoCAD. It supports almost all the file
formats supported by AutoCAD.

IV.2.2 Environmental requirements
(O Above CPU586, above PIII or PV recommended CPU 586
2 Memory, above 1G recommended
3 Windows2000/XP. Vista, XP recommended
@ Supports AutoCAD software above the version of AutoCAD2000 and
AutoCAD2004. AutoCAD2005. AutoCAD2007.

IV.2.3 Installation and startup

IV. 2.3.1 Installation

1. You should have installed AutoCAD software before you install AutoCAD_Laser. If
you don’t, please install AutoCAD on your computer first.

2. If AutoCAD software is opened, please close it first.

3. In order to ensure smooth installation, we suggest you to close the Anti-Virus
Software first.

EICAMS e tup
V3 0.2 exe
) VEDCAMZ. O 3.00 In. .. ) ) )
4. Double click on - , the software installation menu will pop up as
Figure 2-1:

Welcom to use{®<aH-{# B )

1. Includes two options: CorelDraw_Laser and

Install Driver/JEahSede | AutoCAD_Laser.. Select AutoCAD_Laser

Type/ZER:  |AutoCAD Laser ~ 2. Includes three options: Simplified Chinese,
- ﬁ/ Traditional Chinese, English. Please select
Larmage/ 155 : the software language you need.

[ Locate install path/TEfrEdEizis

Tnatall/ YW i » 3. Click on this button to install.

Figure 2-1 Software installation
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As shown in figure 2-1, select AutoCAD _ Laser, select software language, then click on the
Install button, a prompt menu as shown in figure 2-2 will pop up to show successful
installation.:

RlLaserSetllp
j:) Install Finish!

Figure 2-2 Prompt of instillation completion

IV.2.3.2 Startup

Open AutoCAD, the main menu of AutoCAD will be shown as Figure 2-3:

KEEBCRD RPN D ewaned e w el A=1E3
File Edit ¥iew Insert Format Tools Draw Dimension Modify Window Help — | & x i

DEHE 2@ sOG 72 | - ot OF @, ® T [E [y LesfrRuming bg & | 135025 i

= | VO&WHOo = £ O ByLayer Sff:ng | ByLayer ByLaye:

i3
- LaserRunning button
Laserprocess menu

7

s Setting button

)

<

=

r

@

X

~

<

- ;

=y

)
Macro name: LaserInit
Commarnd
Commarnd

Figure 2-3
(1). Click on the LaserRunning button or the LaserRunning menu item, the main menu of
LaserRunning will be shown as Figure 2-4:
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Layer

L .. Processing .. Speed(. .. Min Pow. .. Max Pow. .. o...
EC--er Cut 00000 3000 00000 fes

|

Lazer export |General settings | Machine para | Document | Manual ru * #
Cutting (Optimized route)

Seanning (Reverse interval)

EXPOTt by the order of lapers Speed(mmf/s) | Rewerse ...
|#|Inside to outside

Single inmer to outer, Find V|
D.l\rray
Height:|10 |]Jir: [Up to bot v
DSpace Repay Optimize
DDriginal route Or editing routs
Linefcolumn setup

”~
o

_[Add...] [ 1a |

D Feeding Count:
B Lkems |1 | W |1 | Feeding Distance:
N I S
DEnable center diztance [Track Frame] [ Cut Frame ]
DDverall handle
[ Bestrewing bresdth... | Position [ Find Con | [coms v|  Display|All Layer v
[ SaveTolFile ][ UFilelut ][Pausefcontinue ][ Stop ][ Frocess ] H| | I| | Backgr ound [—]About___ [—]Close

Figure 2-4
Note: this menu will not pop up when AutoCAD is not plotting at present.

(2). Click on the Setup button or the Setup menu item, the dialog box of Setup will pop up
as shown in Figure 2-5:

Setting D_q

File Format:

Curwe Frecsion(¥):

{(*) DXF - AutoCAD Files
Curwa Frecsioni%): (100

hik

|:| Output Text:

Delete Repeated Track:

Speed Unit mmy =

II

185 "Language: |English

—

Fassword Setting. .. ]

[ ox | [Ca.m:el ]

Figure 2-5

2.1 Operation instruction of AutoCAD _Laser. (Almost the same to that of CoreDraw_Laser
please refer to the operation instruction of CorelDraw_Laser).

[EEN
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V Attached

Bitmap Creation Flow

Step one: Startup Photoshop

Step two: Select the menu File/Open to open a picture:

figure 5-1

Step three: Select the size and the precision of the picture

1. Open the menu Image/Image Size, a window will pop up, as shown below:

Pixel Dimensions: 1.57M

it e ¥ 7,
Height: | 800 pixels b -

Document Size:

Width: | 24.24 cm v ]

Height: | 28.22 cm v

N

Resolution: | 72 pixelsfinch %

Scale Styles
Constrain Proportions

Resarmple Image: | Bicubic v
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Figure 5-2

2. In the column Document Size/ Height and Width, input the value you wanted, figure 5-3
followed;
3. Inthe column Document Size/ Resolution, input the converted graph precision(600~1200

pixels per inch is recommended, the higher resolution, the clearer converted graph);

Image Hize r5_<|
Pixel Dimensions: 53.2M (was 1.57M)
Width: | 3937 pixels w

i

Height: | 4724 pixels '

Document Size:

Width: | 10 cm “

il

Height: | 12 om w

Resolution; | g pixelsfinch

[ Constrain Proportions

Resample Image: | Bicubic v

Figure 5-3

Such as figure 5-3: the converted graph size is 10cm*12cm, the resolution is 1000 pixels
per inch;

4. Push on the OK bottom.

Step four: Select the menu Image/Mode/Grey Scale, take out the color information.
Step five: To create net-dot bitmap, two methods are discussed below:
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Method one:
1. Select the menu Image/Mode/Bitmap, a window will pop up as below:

Bitmap D_(|
Resolution
Input: 1000 pixels/inch

__Cancel
Dutput: | 1000 pixels/inch b
Method
Uge: | Halftone Screen... w

50% Threshold
Pattern Dither
Diffusion Dither

Figure 5-4

2. Select (T) , (P) , (D) or (H) , which method is you wanted;

3. To solid graph, Please select (T) , to create some scan graph of the character or of the logo
design. To cross line graph, may select one of (P), (D) or (H) , to create some different
effect. Generally speaking, select (H) .

4. if (H) selected, a window will pop up:

Halftone Screen rz'
Halftone Screen [T]
Frequency: I?'D—I linesfinch 1w __Canl:ZE|
Angle: degrees
Shape: 3

Figure 5-5
In this window, frequency (F) , that’s to say, the precision of the cross line, may be
10~60 lines per inch;
Angle (N) may be 45 degree;

In column Shape (H) , circle is selected generally.

5. Push on the bottom OK.

Method two:

1. Select Filter/ Pixelate / Color Halftone , a window will pop up, such as figure 5-6.
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2. Confirm Max Radius, which is 4~127 pixels, to confirm the size of the color halftone

gridding. The calculating method followed: graphics resolution*0.71/ gridding precision.

For example: as shown in figure 5-1, the resolution is 1000 pixels per inch, the wanted
gridding precision is 60 DPI, then, the max radius is 12, the expression followed:
1000*0.7/60=12.

3. Confirm the net angle of the graph channels.

Input the net angle value for some of the graph channels, the angle is -360~+360 degree,
which is the angle of the net dot and the horizontal line.

Note:

To grey graph, only channel 1 selected,;

To RGB graph, channels 1,2 and 3 selected, then red, green and blue channels are
corresponding;

To CMYK graph, all four channels selected, then cyan, magenta, yellow and black
channels are  corresponding.

Color Halftone §|
Max. Radius: 5| (Pixels)
Screen Angles (Degrees):
Channel 1: 108 Default
Channel 2: 152
Channel 3: an
Channel 4: 45

Figure 5-6

4, push on the OK bhottom;

5. Inthe menu Image/Mode/Bitmap, Select 50% Threshold, to convert the graph to one-bit
bitmap.

For example, after filter processing, the RGB graph, such as figure 5-7-1, will be
converted to a bitmap, as shown in figure 5-7-2.
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) s

Figure 5-7-1 Figure 5-7-2

(1)Select Image/Rotate Canvas/Flip Horizontal to rotate the graph;
(2)Select the menu File/Save As to save the graph file, BMP format selected;
(3)All things are done.

Some methods of drawing in Photoshop aren’t discussed in this file, if needed,
please consult the Manuals of Photoshop or some related books.
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VI User Parameters

(1) Cutting Parameters (Only affect cutting arts)

-

-

-

Idle Move Speed: this parameter decides the highest speed of all non-lighting
lines for the machine in the movement process.

Idle Move Acceleration: it means the highest acceleration of all non-lighting
lines. Idle stroke speed and idle stroke acceleration can be set higher to
reduce the working time of the whole figure, but if they are set too high, it may
cause the jarring of track, so comprehensive consideration should be given to
the setting.

Turning Speed: it means the speed of turning at the acute-angle corner,
which is also the highest speed in the whole cutting process.

Turning Acceleration: it means the acceleration of turning at the acute-angle
corner when cutting. If the two speeds are set too high, jarring will happen to
the turning; if set too low, it will influence the cutting speed.

Cutting Acceleration: it means the highest acceleration value in the whole
cutting process.

Cutting Mode: it is divided into high-speed cutting and precision cutting. In
high-speed cutting, priority is given to the cutting speed, but in precision
cutting, the cutting effect.

Acceleration Mode: it is divided into T acceleration and S acceleration. T
accelerate will quicken the whole cutting process, but it will result in that its
cutting effect is inferior to that of S acceleration.

(2) Scanning Parameters (Only affect scanning arts)

-

X-axle Starting Speed

2 Y-axle Starting Speed

-
-

X-axle Acceleration
Y-axle Acceleration
The above four parameters are used to set the starting speed and

acceleration of two axles on the scanning. The higher the two speeds are, the

quicker the scanning is.

2 Scanning Line-feed Speed: this parameter is specially used to control the

highest speed at which that the previous line vertically moves to the next line

in the scanning mode. If the space between lines is larger during the scanning

or if the distance of each block is larger during the scanning and deblocking of

figure, it iIs necessary to position each line or block accurately. In such a case
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the speed of scanning line-feed can be set as a lower value.

2 Scanning Mode: it is divided into general mode and special mode for option.
If special mode is used, the laser power should be increased. The smaller the
speckle percentage is, the more the laser power reduces. The laser power to
set should be larger in order to reach the same scanning depth. The purpose
to select the special mode is to make the laser light at high power and short
time. On the depth scanning the effect that the bottom is flatter is obtained,
but it should be noticeable that if the speckle adjustment is not appropriate, it
can achieve this goal. If the high power remains short, the lighting mode will
influence the life of the laser. The system will default the selection of general
mode.

2> Speckle Size: When the general mode is selected as the scanning mode, this
parameter will become ineffective; when the special mode is selected, this
parameter will become effective. The controller will control this parameter
among 50%~99%.

A

®x | The cutting and scanning parameters can’t exceed the

limited ones in the axle parameters. If so, the setting will

Prompt
become ineffective and the system will automatically cover

the parameters with the axle parameters.

(3) Reset Parameters
> Reset Speed: it means the speed of X/Y-axle linkage reset to the origin.
2 X-axle Startup Reset
2 Y-axle Startup Reset
2 Z-axle Startup Reset
2 U-axle Startup Reset
You can select “Yes” or “No” in the field of the above four parameters, which is
used to confirm whether each axle can be reset on the startup.

(4) Frame Setting

2 Bordering Mode: “Blanked Bordering” means idling to start border preview;
“Outputted Border Cutting” can manually cut off the well-processed figure;
“4-corner Dotting” means to emit the light at four corner points of the frame to
make a point and turn off light. The size and position of this figure can be
checked intuitively through the four points. The bordering speed is the speed
value set on the keyboard when the system is idle. For light output, its

minimum/maximum power is the corresponding value set on the keyboard
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-

-

ﬂml frame of the figure on the preview/cutting of frame.

when the system is idle (The lasering power on the 4-corner dotting means
the well-set maximum power).
Margin Distance: It means whether to extend a certain length outside the

®x | If the frame crosses the border, the interface will prompt it.
If the Enter key is pressed at this time, the system will cut

the border at the maximum/minimum coordinates first, and
then border the figure. This bordering can be given up.

Prompt

(5) Other User Parameters

-

-

-

Y¥Y

Array Mode: Two-way array or one-way array can be selected. Two-way
array means the to-and-fro cutting of array in sequence; one-way array
means the cutting of array from one direction to another. On selecting
one-way array, the elements of each array are the same in action mode and
completely uniform in action fluency, which takes a little more time than
two-way array. Two-way array is the default option.

Back Position: The origin (the relative origin) and the machine’s absolute
origin can be selected. This parameter decides the parking position of laser
head after each work.

Before-feeding Time Lag: settable at 0~300s. The lagged time can facilitate
user’s feeding and picking on the feeding device.

After-feeding Time Lag: settable at 0~9.9s. It can facilitate the feeding
device’s delaying in jarring after moving to the correct position and waiting for
the 2"¢ work after the feeding axle stands still completely.

Focus Setting: it means the distance from the focal point of laser head lens to
Z-axle origin. When there is no automatic focusing function, this parameter
becomes invalid.

Backlash X: The X axes’ backlash, accurate to 1um.

Backlash Y: The Y axes’ backlash, accurate to 1um.
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VIl Instruction on the Machine Parts

Water sensor switch
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